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About this document

The products IBM® WebSphere® Business Integration Server Express and IBM(R
WebSphere® Business Integration Server Express Plus are made up of the
following components: InterChange Server Express, the associated Toolset Express,
CollaborationFoundation, and a set of software integration adapters. The tools in
the Toolset help you to create, modify, and manage business processes. You can
choose from among the prepackaged adapters for your business processes that
span applications. The standard processes template--CollaborationFoundation--
allows you to quickly create customized processes.

Audience

This document is for IBM consultants and customers. You should be familiar with
PeopleSoft and WebSphere Business Integration Server Express Plus adapter
development.

Related documents

The complete set of documentation available with this product describes the
features and components common to all WebSphere Business Integration Server
Express Plus installations, and includes reference material on specific components.

You can download, install, and view the documentation at the following site:
http:/ /www.ibm.com/websphere/wbiserverexpress/infocenter

Note: Important information about this product may be available in Technical
Support Technotes and Flashes issued after this document was published.
These can be found on the WebSphere Business Integration Support Web
site, |http:/ /www.ibm.com /software/integration /websphere /support/|
Select the component area of interest and browse the Technotes and Flashes
sections.

Typographic conventions

© Copyright IBM Corp. 2004

This document uses the following conventions:

courier font Indicates a literal value, such as a command name, file
name, information that you type, or information that the
system prints on the screen.

bold Indicates a new term the first time that it appears.
italic, italic Indicates a variable name or a cross-reference.
blue text Blue text, which is visible only when you view the manual

online, indicates a cross-reference hyperlink. Click any blue
text to jump to the object of the reference.

{1 In a syntax line, curly braces surround a set of options from
which you must choose one and only one.

[] In a syntax line, square brackets surround an optional
parameter.

In a syntax line, ellipses indicate a repetition of the previous
parameter. For example, option[,...] means that you can
enter multiple, comma-separated options.



http://www.ibm.com/software/integration/websphere/support/

< > Angle brackets surround individual elements of a name to
distinguish them from each other, as in
<server_name><connector_name>tmp.1og.

Naming conventions

In this document the following naming conventions are used:

e The connector component of the Adapter for PeopleSoft is referred to simply as
the connector.

e The “connector” refers to the combination of the Vision Connector Framework
and a connector module.
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New in this release

This is the first release of this guide.

© Copyright IBM Corp. 2004
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Chapter 1. Overview of the adapter

This chapter describes the adapter for the PeopleSoft component of IBM
WebSphere Business Integration Server Express Plus. The connector enables the
integration broker, InterChange Server Express, to exchange business objects with
PeopleSoft version 8 applications that use PeopleTools Version 8.18 or later (8.40,
8.41, 8.42, 8.43).

Connectors consist of an application-specific component and the connector
framework. The application-specific component contains code tailored to a
particular application. The connector framework, whose code is common to all
connectors, acts as an intermediary between InterChange Server Express and the
application-specific component. The connector framework provides the following
services between InterChange Server Express and the application-specific
component:

* Receives and sends business objects

* Manages the exchange of startup and administrative messages

This document contains information about the connector framework and the
application-specific component, which it refers to as the connector. It contains the
following sections:

+ |“Connector components”|

* [“How the connector works” on page 3|

For more information about the relationship of InterChange Server Express to the
connector, see the System Administration Guide.

Connector components

The Adapter for PeopleSoft contains the connector and at least one PeopleSoft
Business Component and Component Interface. shows the connector and
its relationship to the PeopleSoft application. The integration broker is InterChange
Server Express.

© Copyright IBM Corp. 2004 1
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Figure 1. Connector architecture

Connector for PeopleSoft 8

The connector, which is written in Java, complies with IBM business integration
system standards for adapters. It establishes a PeopleSoft session object, and uses
the standard connector methods to process components.

Business components, component interfaces, and records

The connector requires a PeopleSoft Business Component and Component Interface
for each hierarchical business object that it processes.

The adapter does not include PeopleSoft-specific business objects or the
Component and Component Interface that must be associated with each business
object. These objects must be created by the person who implements the connector.
However, to assist in business-object development, the adapter includes a sample
PeopleSoft-specific business object. This sample is located in the
connectors\PeopleSoft\samples directory within the product directory. For
information on creating a Component Interface and its corresponding business
object, see|[“Component interface and business object relationship” on page 28, For
information on creating the required classes and methods, see |‘Generating APIs’]

Note: In this document backslashes (\) are used as the convention for directory
paths. All file pathnames are relative to the directory where the product is
installed on your system.

Event-processing components

To enable event notification, the adapter provides the CW_EVENT_vX Project,
which includes:

2 Adapter for PeopleSoft User Guide



* Fields
The fields store event information.
¢ Records

The records include an event table (CW_EVENT_TBL), an archive table
(CW_ARCHIVE_TBL), and a function library (FUNCLIB_CW). The function
library contains the connector-specific event-notification functions that are called
from Components and Records during SavePostChg() PeopleCode events. For
more information, see |”Pr0cessing application events” on page
“cw_publish_events() Function” on page 17} and ["Event and archive tables” on|

page l8l

e Component

The CW_EVENT_BC Component enables events to be viewed online. It also
provides the appropriate structure for the Component Interface required for
event processing. The Component Interface exposes the fields from the
CW_EVENT_TBL record that are required for the connector’s processing. The
CW_EVENT_BC Component contains the CW_EVENT_TBL record.

* Component Interface

The CW_EVENT_CI Component Interface exposes the fields and records of the
component as the properties and methods necessary for event processing.

¢ Menu Definition

The CW_EVENT_MNU Menu Definition enables event pages to be displayed
online.

How the connector works

This section describes:

+ |“Interacting with the PeopleSoft application”]

* |"Processing business object requests” on page 4|

+ |“Processing application events” on page 6|

Interacting with the PeopleSoft application

At startup, the connector creates a session object through which it connects to the
PeopleSoft Application Server. Connecting to the Application Server gives the
connector access to the APIs for all the Component Interfaces that correspond to its
supported business objects. The server also provides access to the PeopleCode and
the Application Designer objects included with the adapter for event notification.

Each Component Interface (and its associated Business Component, Records,
Fields, Scrolls, and PeopleCode) contains all the information required by the
connector to process a hierarchical WebSphere business object for PeopleSoft.
Because each Component Interface encapsulates its Business Component’s data and
processing logic, the connector does not replicate this processing logic. For
example, the connector need not explicitly handle duplicate record checks,
edit-table validations, or security.

If an error occurs within the connector or during its online processing within the
PeopleSoft application, the connector’s application-specific component sends the
FAIL return code to the connector framework, which sends it to InterChange Server
Express. If the connector loses its connection to the Application Server, the
connector’s application-specific component sends the return code of
APPRESPONSETIMEOUT, and then the terminate() method is invoked on it.

Chapter 1. Overview of the adapter 3



For information on how the connector processes data in a business object, see
(Chapter 3, “Understanding business objects for the connector,” on page 27|

Processing business object requests

When the connector receives a business object request to change data in the
application, the connector processes hierarchical business objects recursively. In
other words, the connector processes each child business object until it has
processed data for all levels in the Component Interface associated with the
business object.

When processing a business object request from InterChange Server Express, the
connector calls PeopleSoft APIs from the session object in the following order:

1. The connector uses the getComponent ("ciName") method to return the
Component Interface associated with the business object. The Component
Interface’s name is stored in the application-specific information property at the
business-object level of each business object.

2. If the business object requests data creation or modification, the connector
inserts or changes values in the application. If the business object requests data
retrieval, the connector obtains values from the application.

* For a Create or Update request, the connector uses the setfFieldName (value)
method to set each field on the Component Interface for which it obtained a
value in step 1.

If the application-specific information of a key attribute specifies that the
PeopleSoft application generate the unique ID, the connector sends the
business object to the application with the string NEXT specified as the value
of the attribute. For information on using the NEXT string in a WebSphere
business object for PeopleSoft, see|“Application-specific information at the
[attribute level” on page 47

If the business object’s application-specific information defines
setInteractiveMode as true, entering or exiting each field triggers the
associated business logic in the underlying component, which immediately
publishes errors to the PeopleSoft PSMessage collection queue.

» For a Retrieve request, the connector uses the getFieldName () method
without specifying a value.

For information on how the connector processes data in a business object, see
[Chapter 3, “Understanding business objects for the connector,” on page 27 For
information on connector-specific properties, see [’Connector-specific|
[properties” on page 20}

3. After processing a Create or Update request for an entire business object,
including all its child business objects, the connector invokes the Component
Interface’s Save() method. If successful, the Save() method executes a single
COMMIT statement. If the business object’s application-specific information
defines setInteractiveMode as false, invoking the Save() method triggers all
FieldEdit business logic associated with the records and fields of the underlying
component. All PeopleCode errors are published to the PSMessage collection
queue.

4. If the PeopleSoft system generates the unique identifiers (IDs) during a Create
request, the connector uses standard PeopleSoft auto-numbering functionality
(that is, built-in functions) to retrieve the most recently used ID, and populate
the business object with a new one.

5. The connector’s processing uses all the business logic that is provided in the
associated Component Interface.

4 Adapter for PeopleSoft User Guide



If a connection error is detected when the connector is processing a business object
request, the connector’s application-specific component logs a fatal error and sends
the return code of APPRESPONSETIMEQUT to trigger email notification. The connector
is then terminated.

The following sections describe request verb processing:

* |[“Processing create requests’]|

» |“Processing retrieve requests” on page 5|

+ |“Processing update requests” on page 5§

* [“Processing delete requests” on page 6|

» |“Processing existence requests” on page 6

Processing create requests

When InterChange Server Express sends a business object request with the Create
verb, the connector uses PeopleSoft’s Create() method to create a new instance of
the Component Interface. If the instance passes all PeopleSoft business logic as the
transaction proceeds, it is saved in the application. The object created in the
application contains all values contained in the business object, including all child
business objects.

For more information about processing a create operation, see |“Create operations”]

Processing retrieve requests

When InterChange Server Express sends a business object request with the
Retrieve verb, the connector uses PeopleSoft’s Get () method to verify that a unique
instance of the corresponding Component Interface exists. This Get () method
instantiates the Component Interface, allowing the connector to load its values into
the business object. The business object that the connector returns to InterChange
Server Express exactly matches the instance of the Component Interface.

In other words, the value of each simple attribute of the business object returned to
InterChange Server Express matches the value of the corresponding Property Field
in the Component Interface. Also, if the returned business object is hierarchical, the
number of individual business objects in each of its arrays matches the number of
levels or collections in the Component Interface for that array.

For more information about processing a retrieve operation, see [‘Retrieve
foperations” on page 38}

Processing update requests

When InterChange Server Express sends a business object request with the Update
verb, the connector modifies an existing instance of the Component Interface. If the
instance passes all PeopleSoft business logic as the transaction proceeds, it is saved
in the application.

The object updated in the application exactly matches the request business object.
The connector updates all simple Property Fields except those whose
corresponding attribute in the request business object contain the value CxIgnore. It
inserts all child business objects contained in the request business object.
Depending on the value of its KeepRelationship application-specific information
parameter, the connector either deletes or retains child business objects that do not
exist in the request business object.

Chapter 1. Overview of the adapter 5



For more information about processing an update operation, see
foperations” on page 41}

Processing delete requests

Because PeopleSoft does not support deletion of transactions, the connector does
not either. The standard behavior for processing a logical delete is to use the
Update verb to change the status of the business object’s EffectiveStatus attribute
to “I” (Inactive).

However, to cause the connector to support a delete of an entire object, do the
following:

1. Create a user-defined PeopleCode method that performs deletion within
PeopleSoft.

2. Expose the method through the appropriate Component Interface.

Processing existence requests

When InterChange Server Express sends a hierarchical business object request with
the Exists verb, the connector checks for an instance of the Component Interface.
The connector’s application-specific component returns SUCCEED if the instance
exists in the application, and FAIL if the object does not exist.

Processing application events

Event notification involves three main processes:

* [“Event publication”’}—Events are published to the connector’s event table
(CW_EVENT_TBL), which is stored in the PeopleSoft database.

* [“Event polling”}—The connector polls the event table through the PeopleSoft
APIL.

+ |“Event archiving” on page 7}—The connector archives events into its archive
table (CW_ARCHIVE_TBL).

Event publication

To publish events to the connector’s event table, the PeopleSoft application uses
PeopleCode and Application Designer objects included with the adapter. For
information about these objects, see|“Event-processing components” on page 2}

The event publication process uses the cw_publish_events() function, which is
stored in the FieldFormula event of the FUNCLIB_CW record. You must declare
and call this function from the SavePostChg() PeopleCode of the component
involved in the event.

Note: This procedure does not use a Component Interface.

For more information, see |”cw_publish_events() Function” on page 17I

Event polling

The connector polls the event table at a regular, configurable interval. It searches
for events first by status, then by the value of the connector property ConnectorlID.
If this value is null or blank, the property will not be used for the search. When
the connector processes an event, it immediately updates the status to
INPROGRESS (a value of 3). Any pending INRPOGRESS events are reset to
READYFORPOLL (a value of 0) during the connector’s initialization.

The connector uses the CW_EVENT_CI Component Interface’s Find() method to
poll the event table. This method returns a Collection of events with the status
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READYFORPOLL. The connector loops through the Collection, obtaining the name of
every business object listed in the CW_EVENT_TBL.

The connector uses the API to set and get property values, gathering event

information for each event returned in the Collection. The connector checks to
determine which business objects are subscribed. For subscription information
specific to InterChange Server Express, see the broker’s implementation guide.

* For each subscribed business object, the connector retrieves the name of its
associated Component Interface. Using the key values listed in the
CW_OBJ_KEYS field, the connector instantiates the Component Interface
involved in the event and copies the information into an application-specific
business object. After creating the business object, the connector passes it to
InterChange Server Express and archives the event.

* For unsubscribed business objects and business objects that generate errors, the
connector moves the event to the archive table and updates its status.

* The connector supports the delete verb for outbound objects. The key values of
the business object instance are set, and the object is sent to InterChange Server
Express.

For more information, see [“Event and archive tables” on page 18

Event archiving

While the CW_EVENT_CI Component Interface is instantiated, the connector calls
the cw_archive_events() user-defined method for each event it processes. This
method, which is in the form of PeopleCode, sets the Archive flag to Y. Setting this
flag causes the SavePostChg() PeopleCode to archive the event when the user
invokes the Save() method. The archive table also records the date and time the
event was processed.

Note: The SavePostChg() PeopleCode is included with the Project.

You can use the archive table to query for event history or to troubleshoot
problems in event processing. For example, all unsubscribed events have a status
of unsubscribed.

Because there are potential failure points associated with the processing of events,
the event management process does not delete an event from the event table until
it has been inserted into the archive table.

Event notification process flow
ﬂlustrates the event notification process flow. The integration broker is
InterChange Server Express.
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Figure 2. Event notification process flow

Integration Broker

PSFT_BO

The following describes the steps illustrated in :

1. When a user saves a change online in a Component, the SavePostChg() method

calls the cw_publish_events() function.

2. The cw_publish_events() function, which has four parameters, does the

following:

* Gets the application-specific business object name from its first parameter.

* Gets the name of each key required to instantiate the Component Interface
that corresponds to the application-specific business object. It gets the key
names and their respective values from its second parameter.

* Sets the priority of the event based on the value of the third parameter.
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Note: Because the application can publish multiple events from a single Save
action on a Component, the connector uses the value of the third
parameter to prioritize events. If sequence order is important to an
object, it should specify a priority when it calls the
cw_pubTlish_events() function. For example, a Location would have a
higher priority than a Department because the Location must be
processed first.

* Sets the CW_CONN_ID field to the value of the fourth parameter, which also
corresponds to the ConnectorID connector property. The default is
PeopleSoftConnector.

* Generates the unique ID for the event.

* Evaluates the PeopleSoft system variable %Mode to identify the verb
associated with the event.

e Inserts the event into CW_EVENT_TBL.
For more information, see|“cw_publish_events() Function” on page 17}
. The connector sorts events in CW_EVENT_TBL by priority.

4. The connector polls the event table for events at the interval specified by its

PollFrequency| configuration property, picking up no more than the number of
ﬁ

events specified by its [PollQuantity| configuration property. To do the polling,
the connector instantiates the CW_EVENT_CI Component and invokes the
Find() method.

Note: The connector uses a different thread from the one used for request
processing.

. For each record retrieved from the event table, the connector checks whether it
subscribes to the event data.

If the data is not subscribed, the connector moves the event record from
CW_EVENT _TBL to CW_ARCHIVE_TBL with a status of unsubscribed.

. If the data is subscribed, the connector uses the event record’s key fields to
instantiate the appropriate Component Interface, from which it retrieves
complete data for the event.

. After retrieving complete event data from the Component Interface, the
connector instantiates the appropriate application-specific business object.

. The connector sends the application-specific business object to InterChange
Server Express.

. The connector calls the cw_archive_events() function, which sets the Archive
flag to Y and sets the status and processing time appropriately. Setting the
Archive flag causes the SavePostChg() PeopleCode to copy the event
information to the archive table and delete the event from the event table.

Chapter 1. Overview of the adapter 9
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Chapter 2. Installing and configuring the connector

This chapter describes how to install and configure the Adapter for PeopleSoft and
how to configure the PeopleSoft application to work with the connector.

This chapter contains the following sections:

. "Prerequisites’l

+ [“Installing the adapter and related files” on page 13|

* |“Installed file structures” on page 13

s

* |“Enabling the application for the connector” on page 14

. "’Conﬁguring the connector” on page 20|

* [‘Starting the connector” on page 24

. "’Stopping the connector” on page 2§|

Compatibility
The adapter for PeopleSoft Guide is supported on the following adapter
framework and integration brokers:

* Adapter framework: WebSphere Business Integration Server Express Plus Adapter
Framework

* Integration brokers: InterChange Server Express
Note:
For instructions on installing InterChange Server Express and its

prerequisites, see the Installation Guide for WebSphere Business Integration
Server Express.

Prerequisites

Before you use the Adapter for PeopleSoft, verify that your system has the
required software. Also, you must perform operations such as creating the
connector’s user account, mapping an environment variable, and generating
PeopleSoft APIs. This section describes:

* [“Required software for using the connector”|

« |"Required operations for installing the connector” on page 12|

Required software for using the connector

To access a designated Component Interface and its underlying PeopleSoft business
logic, the connector requires two layers of PeopleSoft API classes. Before you use
the connector, install the following:

* psjoa.jar— The connector uses this API to connect to the Application Server
through the BEA Systems’ Jolt port. The connector also uses this API to send
objects through the Application Server. This file is included with the current
version of PeopleTools and is located in the following directory:

Windows
%PS_HOME%\web\PSJOA

© Copyright IBM Corp. 2004 11



| End of Windows

Save this file to the directory documented in [“Installed file structure on|
[Windows” on page 13| For more information on retrieving PeopleSoft’s API files,
see PeopleSoft’s Installation and Administration Guide.

* Component Interface API—The connector accesses this layer only after a session
object has been created and a connection to the PeopleSoft Application Server
has been established using psjoa.jar. The Component Interface API provides
access to all of a Component Interface’s exposed objects and PeopleCode
methods. You must manually generate this API in Application Designer, as
described in [“Generating APIs” on page 33|

Required operations for installing the connector

This section describes required operations that must be performed before you use
the connector:

* Map the CLASSPATH environment variable to the following directories:

Windows
%ProductDir%\connectors\PeopleSoft\dependencies

| End of Windows

Also ensure that psjoa.jar is defined in the CLASSPATH.

» Create a user account in PeopleSoft for the connector. For more information, see
[“Creating a user account in PeopleSoft.”|

* Configure the PeopleSoft user account so that it does not time out. For more
information, see [Configuring time-out for the user account” on page 13|

* Delete any previously installed versions of the connector. Also, delete all
previous customizations made in PeopleSoft for the connector. For example,
delete all connector-related Menus, Pages, Records, Message Definitions
Components, and Component Interfaces. Also, delete the connector’s event and
archive tables. Typically, these objects are stored in a connector-specific project
that you can open in Application Designer.

Note: If you install a WebSphere Business Integration Adapter on the same
machine as a previous installation of the connector for ICS, the ICS
connector will not run unless you manually switch the IBM WebSphere
system environment variable to point to the desired product path.

* Generate Component Interface APIs. For more information, see
[APIs” on page 33

Creating a user account in PeopleSoft

Before installing the connector, you must create a user account in the PeopleSoft

application. The account:

* Can have any valid PeopleSoft user name and password.

* Must have privileges to retrieve, insert, update, and delete data from the
appropriate Pages, Components, and Component Interfaces in the PeopleSoft
system. For example, for the connector to process customer data, the connector
user account must have privileges to work with relevant Customer components.

* Uses General PeopleSoft Security. For more information, see the Security section
of Administrator Tools in PeopleBooks.

12 Adapter for PeopleSoft User Guide



* Must be configured so that the session never times out. For more information,
see ["Configuring time-out for the user account.”|

Configuring time-out for the user account

Because the connector uses the Component Interfaces (and the Component
Processor on the Application Server) to insert and extract business objects from the
PeopleSoft database server, the Application Server must be running. If the user
account times out, the Component Processor closes, and the connector logs an
error message every time it attempts to access the PeopleSoft system (that is, at
every poll, at every create, at every retrieve, and at every update).

To configure the user account to never time out, do the following;:
1. In the PeopleSoft application, select PeopleTools from the Go menu option.

2. Select Maintain Security from the PeopleTools menu option.

3. Select Permission Lists from the Use menu option.

4. Select Sign-On Times from the Permission Lists menu option

5. From the list of permissions, select the one affiliated with the connector’s user

account.

6. On the General tab, select Never Time-Out, and select Can Start Application
Server, if not already selected.

Installing the adapter and related files

For information on installing the adapter, see the discussion of installing from the
Adapter Capacity Pack for WebSphere Business Integration Server Express Plus, in
the Installation Guide for WebSphere Business Integration Server Express, located in the
WebSphere Business Integration Server Express Infocenter at the following site:

http:/ /www.ibm.com/websphere/wbiserverexpress/infocenter

Installed file structures

Installed file structure on Windows

describes the Windows file structure used by the connector.

Table 1. Installed Windows file structure for the connector

Subdirectory of%ProductDirS% Description

\connectors\PeopleSoft

..\bin

..\Tib

* Contains the connector’s CWPeopleSoft.jar and the
start_PeopleSoft.bat files.

* Contains an executable named
EventNotificationInstall.exe, which contains the
event notification objects

* Contains a file named SavePostChg.txt, which contains
a sample of the PeopleCode required to process events
Please verify that this folder contains the CWConnEnv.bat
file.
Please verify that the directory contains the WBIA. jar file.
This file corresponds to ADK 2.2.0. If an older version of
ADK is required, please refer to the Connector Development
Guide.
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Table 1. Installed Windows file structure for the connector (continued)

Subdirectory of%ProductDirS% Description

\connectors\PeopleSoft\dependencies + Contains the psjoa.jar files that you must copy from

the current version of PeopleTools.

* Contains the PSFTCI. jar file, which contains all the
PeopleSoft Component Interface class files that
PeopleSoft generates after you build and compile the
APIs.
\connectors\messages Contains the PeopleSoftConnector.txt file, as well as
PeopleSoftConnector_lI1_TT.txt files (message files
specific to a language (_/) and a country or territory

(_TT)).
\connectors\PeopleSoft\samples Contains a sample PeopleSoft-specific business object.
\repository\PeopleSoft\ Contains the CN_PeopleSoft.txt file.

Enabling the application for the connector

Before you can use the connector with your PeopleSoft application, you must:

* Define required Components, Component Interfaces, Menus, Pages, Records, and
PeopleCode in your PeopleSoft application. To facilitate the process of defining
required business objects, the adapter includes a sample business object. For
more information, see |Chapter 3, “Understanding business objects for thel
connector,” on page 27|and [Chapter 4, “Generating business object definitions|
using PeopleSoftODA,” on page 51

* Import the Project included with the adapter. This Project contains the
components required for event processing, build the required tables, and build
the API files.

Note: Importing the Project is necessary only when you use the connector to
process events.

This section describes:

+ |“Installation operations required to process application events” on page 14

+ [“Code for processing application events” on page 17

Installation operations required to process application events

This section describes required operations that must be performed when you use
the connector to process application events. Perform this installation before you
use the connector for the first time.

Installing event-processing components involves the following processes:

+ |[“Importing the project” on page 14|

* [“Building required objects” on page 19
* |“Building the API files” on page 16|

Importing the project

1. Run the file that unzips the Application Designer project files into the
designated folder. From the
%ProductDirS%\connectors\PeopleSoft\dependencies directory, select the
EventNotificationInstall.exe file.

Note: This file is available only on Windows.
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Running this file with the default values creates a Projects directory within the
dependencies directory. The project name is CW_EVENT_Vx, where Vx identifies

the version number.

2. Open PeopleSoft’s Application Designer and select: Copy Project From File...

from the File menu.

3. In the menu that appears, select the import directory into which the project was
unzipped. |Ei§ure 3|illustrates the screen within PeopleSoft.

Copy Project from File

|mport Directon: IDPLESDFT&DEF‘ENDENCIES\F’HDJEETS| _I

Project Mame:

I= | Ovenide Dependencies Copy I Cancel

Figure 3. Importing the project

4. Click Copy and verify the list of components with those listed in

[“Event-processing components” on page 2|

Building required objects

To build the event and archive tables and the function library:

1. Build the tables by selecting Project... from the Build menu.

2. In the dialog box that appears, verify that the CW_EVENT_TBL, FUNCLIB_CW
and CW_ARCHIVE_TBL appear as illustrated in

e o |
Cw_ARCHIVE_TBL
Cw_EVENT_TBL Cancel
FUNCLIB_Cw
Seftings... l
—Build Options————————
¥ Cieate Tables

¥ Cieats Vi
I Aker Tables

- Build Execute Options ————
" Build script file
(¥ Execute SOL now
"~ Execute and build script

Figure 4. Building the tables
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3. Select the build options “Create Tables” and “Execute SQL now”. Also, click the
Settings button and, in the window that displays, verify that “create table if it
already exists” and “recreate index if it already exists” are selected.

4. Click Build.
5. Log on to a SQL editor using an ID with appropriate database privileges. The
default ID is SYSADM/SYSADM.Initialize the CW_EVENT_NOT Field on the

FUNCLIB_CW Record with a value of zero. To do so, run the following
statement:

INSERT INTO PS_FUNCLIB_CW (CW_EVENT NOT) VALUES ('0');

Building the API files

To build the CW_EVENT_CI API files (required when the connector processes only
events) or the Component Interface API files (required when the connector
processes both events and requests):

1. Open the Component Interface CW_EVENT_CI from the project window and
select PeopleSoft APIs from the Build menu.

2. In the Java Classes panel:
* Select the Build box
* In the “Directory containing PeopleSoft package:” field, enter the path for

connector’s dependencies directory (or the directory where all the PeopleSoft
API files reside for your implementation). This is usually:

Windows |
%ProductDirS%\connectors\PeopleSoft\dependencies

| End of Windows |

3. From the “Select APIs to Build:” field, select CWEVENT_CI and its associated
collection. illustrates the screen within PeopleSoft.

Build PeopleS oft APl Bindings E
—COM Type Libramy 1
[~ Build Target Diectory: |G.\HRMSSsp1 ‘bintclient\winkB6_extap __4 |
Type Library Template: | ‘

COM Server DLL Location: IG.‘\HHMS Bzp1ibintclient\winxBE_exta

AutoFegister [V Cleanup Fegisty v

—LC Header Files

™ Buid  Diectomfor headerfil: [D:\Diacle\Dic81%in Bl |
-~ Java Claszes

¥ Buid

Directory contaning PeopleS oft package: lopleﬁuft\dependencies __!
Select APls to Buid: All ] Nnnel

Complntic. CURRENCY_CURRENCY_CD_TBLCollsction |

Intic. CURRENCY Collection

Complntfc. DELETE_ROLE
Complniic. DELETE_ROLE_ROLE_TABLES_Vw/
Complntfc. DELETE_ROLE_ROLE_TABLES “W(Callection

e
Complintic. DELETE_ROLECollection ll Cancel l

Ceamnintie NFIFTE |IGFR PRAFI F

Figure 5. Building APls
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4. Click OK.
5. Compile any API files that you generate, and add them to PSFTCI. jar (if it

exists) or create this file if it does not exist.

Note: The start script or batch file is configured to search for these API files in
a file named PSFTCI.jar in the \connectors\PeopleSoft\dependencies
directory. After you compile these API classes, make a jar file that you
name PSFTCI.jar. If you put this jar file in a different directory, change
the start script or batch file to point to the correct location of these API
classes.

Place the cw_publish_events() function declaration and function call in the
SavePostChg() PeopleCode for each Component associated with an event. For
more information, see [‘Sample PeopleCode declaration and function call” on|

Note: The function must be placed in the SavePostChg() of the Component and
not of the Record.

Define all parameters used in the function call and insert PeopleCode to check
whether the Component has changed before making the function call. This
code eliminates unnecessary calls to the function. Also add a check for %userid
to prevent the connector from ping-ponging (that is, creating an endless loop in
which the connector interprets a data change from a request as a new
application event). For an example, see|“Sample PeopleCode declaration and|
[function call” on page 18

Code for processing application events

The adapter includes the cw_publish_events() function in the FUNCLIB_CW
function library. This function inserts events into the connector’s event table. This
section describes the function and the sample code that calls it.

cw_publish_events() Function
The cw_publish_events() function takes four parameters, all of type String:

8BONAME—contains the name of the WebSphere application-specific business
object for PeopleSoft that is generated for the event

8KEYLIST—contains the name of all keys required to instantiate the Component
Interface that corresponds to the business object named in the &BONAME
parameter. This function uses the GetKey () method for instantiation. Because the
connector uses name-value pairs, the order of the keys is not significant.
However, the names must match those listed on the Component Interface.
Separate multiple keys with a colon or other configurable delimiter, for example,
SETID:DEPTID. For more information, see [“EventKeyDelimiter” on page 21}

&CWPRIORITY1—defines the priority of the event; defaults to 2. This parameter
enables certain events to be processed prior to events with a lower specified
priority. The CW_EVENT_TBL processes events of higher priority first.

&CONNID—contains the name of the connector instance that will retrieve the
event. This parameter is used for event distribution and defined in the
ConnectorID property for the connector. If not using event distribution, use the
value "PeopleSoftConnector”.

Important: You must define these parameters, in proper form, before or during the

function call.
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Using the values specified for its parameters and the information currently
available in the Component Buffer, the function gathers the required information
from the Component and inserts the event in the event table. The function
performs the following:

* Evaluates the PeopleSoft system variable %Mode, which contains values such as
Add and Update/Display, to identify the verb associated with the event

* Uses the key names to gather the current key values from the Component and
creates a list of business object key names and values

* Loads all information into a row, which it inserts into the event table using
PeopleCode built-in functions and methods

Sample PeopleCode declaration and function call

The adapter includes a sample of the PeopleCode declaration and function call in
the savepostchg.txt file in the connector’s samples directory. Replace the business
object’s name and keys with the correct information for your business object and
then copy and paste the code directly into the PeopleCode editor.

Before making the actual function call, use a simple logic test to verify that the
Record or Component actually changed. If it did not change, the connector does
not call the function, which enhances performance. Also verify that the %userid is
not CW. Doing so prevents the connector from interpreting a data change from a
request as a new application event.

The following code is the sample that the adapter provides:

/* Place this code in Component's SavePostChg() and define the four */
/* parameters used in the function call =/

Declare Function cw_publish_event PeopleCode FUNCLIB_CW.CW_EVENT_NOT
FieldFormula;

Component String &BONAMEL;

Component STring &KEYLIST1;

Component String &CWPRIORITY1;

Component String &CONNID1;

&BONAME1 ="Psft_Dept";

&KEYLIST1 = "DEPT_TBL.SetId:DEPT_TBL.DeptId";
&CWPRIORITY = 2;

&CONNID1 ="PeopleSoftConnector";

/* Check if Component Changed before calling function */
If ComponentChanged() and
suserid <> "CW" then

/* Publish this event to the IBM WebSphere
CW_EVENT TBL for polling =/

cw_publish_event (&BONAMEL,&KEYLIST1,&CWPRIORITY1,&CONNID1);

End-if;

Event and archive tables

The connector uses the event table to poll events for pickup. For each event, the
connector gets the business object’s name, verb, and key from the event table. The
connector uses this information to retrieve the entire entity from the application. If
the entity was changed after the event was first logged, the connector gets the
initial event and all subsequent changes. In other words, if an entity is created and
updated before the connector gets it from the event table, the connector gets both
data changes in the single retrieval.
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The following three outcomes are possible for each event processed by a connector:
* Event was processed successfully

* Event was not processed successfully

¢ Event was not subscribed to

If events are not deleted from the event table after the connector picks them up,
they occupy unnecessary space there. However, if they are deleted, all events that
are not processed are lost and event-processing cannot be audited. Therefore, the
adapter provides the archive table to store events deleted from the event table.

describes the columns in the event and archive tables.

Table 2. Event and archive table schema

Name Description Type Constraint

CW_EVENT_ID Internal identifier of the event A unique key NUMBER Primary key
field that identifies each event generated from
within PeopleSoft
CW_CONNECTOR_ID Unique ID of the connector for which the event VARCHAR
is destined. This value is important when
multiple connectors poll the same table.
CW_OBJ_KEYS Keys of the business object, specified in VARCHAR Not null
name-value format. When defining parameters
for a function call (such as cw_publish_events),
the name consists of the table name and field
name separated by a period. Multiple keys are
separated with a colon or other configurable
delimiter, for example:
DEPT_TBL.SetId:DEPT TBL.DeptIdFor more
information, see|“EventKeyDelimiter” on page|
CW_OB]J Name of the business object VARCHAR Not null
CW_VERB Verb associated with the event. A PeopleCode = VARCHAR Not null
function included with the adapter determines
the value (Create, Retrieve, Update, Delete)
based upon the %Mode system variable used by

PeopleSoft

CW_PRIORITY Event priority (0 is highest, n is lowest), which NUMBER Not null

the connector uses to get events on a priority
basis.

CW_DTTM Date and time the event or archiving occurred STRING Default current
date/time (for archive
table, actual event
time). PeopleSoft treats
the datatype for DATE
fields as STRING and
returns the same.

CW_STATUS -2 (Error sending event to InterChange Server =~ VARCHAR Not null

Express)

-1 (Error processing event)

0 (Ready for poll)

1 (InterChange Server Express)

2 (No Subscriptions for the business object)

3 (In Progress). This status is used only in the
event table and not in the archive table.
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Configuring the connector

You must configure the connector’s standard and connector-specific connector
configuration properties before you can run it. To configure connector properties,
use:

* Connector Designer—for the integration broker, InterChange Server Express.
Access this tool from System Manager.

As you enter configuration values, they are saved in the repository.

Standard connector properties

Standard configuration properties provide information that all connectors use. See
[Appendix A, “Standard configuration properties for connectors,” on page 75| for
documentation of these properties.

provides information specific to this connector about a configuration
property in the appendix.

Table 3. Property information specific to this connector

Property Note

AgentConnections Because this connector is single-threaded, do not change
the default value of this property.

CharacterEncoding This connector does not use this property.

Locale Because this connector has been internationalized, you

can change the value of this property. See release notes
for the adapter to determine currently supported
locales.

Connector-specific properties

This section documents configuration properties specific to this connector at
runtime. Connector-specific properties provide a way of changing static
information or logic within the connector without having to recode and rebuild it.

lists the connector-specific configuration properties for the connector. See
the sections that follow for explanations of the properties.
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Table 4. Connector-specific configuration properties

Default
Name Possible values value Required
[AppServerMachineNameOrIP) n/a Yes
ApplicationPassword| Password for the connector’s user account PS Yes
ApplicationUserName| Name of the connector’s user account PS Yes
(ConnectorID)| Name of connector for event distribution null No
ConvertToPrimitiveFloat] true or false false No
EventKeyDelimiter] <NameValueChar><DelimiterChar> Note: Do not =: No
specify a space between the actual characters.
PingComplnterface replace < CHANGEME > with the name of an CHANG Yes
existing component interface ME
m Values are 1 to 500 1 No
PortNumbe The Jolt port number 9000 Yes
ReconnectSessionOnGetFail| true or false false No
Values are lor greater 1 No
true or false false No
true or false false Yes
PeopleTools version number 8.15 Yes

AppServerMachineNameOrIP
The name or IP address of the machine where the Application Server is running.
The connector uses this value only when connecting to the application.

ApplicationPassword
Password for the connector’s user account in the PeopleSoft application.

There is no default value.

ApplicationUserName
Name of the connector’s user account in the PeopleSoft application.

There is no default value.

ConnectoriD

The value of this property is used to search for events in the CW_EVENT_TBL through
the cweventci. It is used for event distribution, when multiple connectors are used
to retrieve specific events. If the value is left blank or null, this property will not
be set prior to invoking the Find() method in the event component interface.

ConvertToPrimitiveFloat
Specifies whether to convert float objects to primitive float objects.

The default value is false.

EventKeyDelimiter

Specifies the two characters in name-value pairs that separate the name from its
value (NameValue character) and the pairs from each other (Delimiter character).
The following example uses the default equals (=) NamelValue character and default
colon (:) Delimiter character:

SETID=1234:DEPTID=5678

The default value is =:
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PIngComplinterface

Pings the component interface to test for network connectivity/session validity.
FAIL is returned when either the session or connectivity are invalid. When the
name of the component interface is given, the connector agent terminates if the
session instance is unable to get that interface, because of either invalid session or
network connectivity issues.

PollQuantity

Number of rows in the database table that the connector retrieves per polling
interval. Allowable values are 1 to 500.

The default is 1.

PortNumber
The Jolt Port Number (not the Tuxedo port number) on the Application Server. The
connector connects to the JSL, not to the WSL.

The default value is 9000

ReconnectSessionOnGetFail

If set to true, the connector automatically creates a new session object and
reconnects to the PeopleSoft application. The connector uses this property only
when the component interface’s Get () method returns a non-critical error or
warning message that terminates the connector’s session object. Typically this
problem arises when an instance has different keys from those used by the
connector.

The default value is false.

SessionPoolSize

Enables the connector to run multiple PeopleSoft session instances. Set this
property to the number of session instances you want to run. Multi-threading is
only available to inbound objects. Each inbound object thread is allocated a session
instance from a pool of free sessions, and then that session instance moves to a
busy pool. When the transaction finishes, the session instance is released back to
the free pool.

When the connector runs multi-threaded, one session instance is reserved for
polling which is single-threaded and performed serially.

SetLangCode

Specifies whether the connector sets the base language immediately after it
connects to the PeopleSoft application. If set to true, the connector uses a
workaround that correctly updates the base language in the base table rather than
in the language table. If you set this property to false, your base tables may not
be updated correctly.

The default value is false.

UseDefaults

If UseDefaults is set to true or is not set, the connector checks whether a valid
value or a default value is provided for each required business object attribute. If a
value is provided, the Create succeeds; otherwise, it fails.
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If UseDefaults is set to false, the connector checks only whether a valid value is
provided for each required business object attribute; the Create operation fails if a
valid value is not provided.

The default value is false.

Version
Specifies the current version of PeopleTools on which the application is running.
The value should be specified to the latest available decimal point.

Creating multiple connector instances

Creating multiple instances of a connector is in many ways the same as creating a
custom connector.

Note: Each additional instance of any adapter supplied with WebSphere Business
Integration Server Express will be treated as a separate adapter by the
function that limits the total number of adapters that can be deployed.

You can set your system up to create and run multiple instances of a connector by
following the steps below. You must:

* Create a new directory for the connector instance
* Make sure you have the requisite business object definitions
¢ Create a new connector definition file

* Create a new start-up script

Create a new directory

You must create a connector directory for each connector instance. This connector
directory should be named:

ProductDir\connectors\connectorInstance
where connectorInstance uniquely identifies the connector instance.

If the connector has any connector-specific meta-objects, you must create a
meta-object for the connector instance. If you save the meta-object as a file, create
this directory and store the file here:

ProductDir\repository\connectorInstance

Create business object definitions
If the business object definitions for each connector instance do not already exist
within the project, you must create them.

1. If you need to modify business object definitions that are associated with the
initial connector, copy the appropriate files and use Business Object Designer
Express to import them. You can copy any of the files for the initial connector.
Just rename them if you make changes to them.

2. Files for the initial connector should reside in the following directory:
ProductDir\repository\initialConnectorInstance

Any additional files you create should be in the appropriate connectorInstance
subdirectory of ProductDir\repository.

Create a connector definition
You create a configuration file (connector definition) for the connector instance in
Connector Configurator Express. To do so:
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1. Copy the initial connector’s configuration file (connector definition) and rename
it.

2. Make sure each connector instance correctly lists its supported business objects
(and any associated meta-objects).

3. Customize any connector properties as appropriate.

Create a start-up script
To create a startup script:

1. Copy the initial connector’s startup script and name it to include the name of
the connector directory:

dirname

2. DPut this startup script in the connector directory you created in

[directory” on page 23|

3. Create a startup script shortcut.

4. Copy the initial connector’s shortcut text and change the name of the initial
connector (in the command line) to match the name of the new connector
instance.

You can now run both instances of the connector on your integration server at the
same time.

Starting the connector

A connector must be explicitly started using its connector start-up script. The
startup script should reside in the connector’s runtime directory:

ProductDir\connectors\connName

where connName identifies the connector. The name of the startup script depends

on the operating-system platform, as shows.

Table 5. Startup scripts for a connector

Operating system Startup script

Windows start_connName .bat

You can invoke the connector startup script in any of the following ways:
* On Windows systems, from the Start menu

Select Programs>IBM WebSphere Business Integration
Express>Adapters>Connectors>your_connector_name.

7

By default, the program name is “IBM WebSphere Business Integration Express”.
However, it can be customized. Alternatively, you can create a desktop shortcut
to your connector.

e From the command line
— On Windows systems:
start_connName connName ICS [-cconfigFile ]
where connName is the name of the connector.
* From System Monitor

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.
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¢ On Windows systems, you can configure the connector to start as a Windows
service. In this case, the connector starts when the Windows system boots (for an
Auto service) or when you start the service through the Windows Services
window (for a Manual service).

For more information on how to start a connector, including the command-line
startup options, refer to the System Administration Guide

Stopping the connector

The way to stop a connector depends on the way that the connector was started,
as follows:

* If you started the connector from the command line, with its connector startup
script:

— On Windows systems, invoking the startup script creates a separate “console”
window for the connector. In this window, type “Q” and press Enter to stop
the connector.

¢ From System Monitor

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.

* On Windows systems, you can configure the connector to start as a Windows
service. In this case, the connector stops when the Windows system shuts down.
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Chapter 3. Understanding business objects for the connector

The connector component of the Adapter for PeopleSoft is meta-data-driven.
Meta-data, in the WebSphere business integration system, is application-specific
data that is stored in WebSphere business objects and that assists the connector in
its interaction with the application. A meta-data-driven connector handles each
business object that it supports based on meta-data encoded in the business object
definition rather than on instructions hard coded in the connector.

Business object meta-data includes the structure of a business object, the settings of
its attribute properties, and the content of its application-specific information.
Because the connector is meta-data driven, it can handle new or modified business
objects without requiring modifications to the connector code. The connector uses
the business object definition and its application-specific information to locate and
manipulate the data in a Component Interface.

The connector makes assumptions about the structure of its supported business
objects, the relationships between parent and child business objects, the format of
the application-specific information, and the Component Interface through which it
interacts. Therefore, when you create or modify a business object that will be
processed by the connector, your modifications must conform to the rules the
connector is designed to follow. If they do not, the connector cannot process new
or modified business objects correctly.

This chapter describes how the connector processes business objects and describes
the assumptions the connector makes. You can use this information as suggestions

for implementing new business objects or as a guide to modifying existing ones.

This chapter contains the following sections:

* |“Business object and attribute naming conventions’]

+ |“Business object structure” on page 28|

* |“Creating a business object” on page 32|

+ |“Business object verb processing” on page 35|

« |“Business object attribute properties” on page 43|

« |“Business object application-specific information” on page 45

Business object and attribute naming conventions

For clarity, use the PSFT_ prefix when you name an business object to represent
data in a PeopleSoft Component Interface. Follow this convention for all child
business objects as well as for the top-level business object. For example, if you
create business objects that represent parent data in the EMERGENCY_CNTCT table and
child data in the EMERGENCY_PHONE table, you might name the corresponding
business objects: PSFT_EmergencyContact and PSFT_EmergencyPhone.

Note: In this document, the term hierarchical business object refers to a complete
business object, including all the child business objects that it contains at
any level. The term individual business object refers to a single business
object, independent of any child business objects it might contain. The term
top-level business object refers to the individual business object at the top of
the hierarchy that does not itself have a parent business object.
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Business object structure

WebSphere business objects that represent PeopleSoft data can be flat or
hierarchical. All the attributes of a flat business object are simple, that is, they
represent a single value (such as a String or Integer).

In addition to its simple attributes, a hierarchical business object can have
attributes that represent a single-cardinality child business object or an array of
child business objects. In turn, each of these business objects can contain
single-cardinality child business objects and arrays of business objects, and so on.

A single-cardinality relationship occurs when an attribute in a parent business
object represents a single child business object. In this case, the child business
object represents a PeopleSoft Collection that can contain only one Record. The
type of the attribute is the same as that of the child business object.

A multiple-cardinality relationship occurs when an attribute in the parent
business object represents an array of child business objects. In this case, the child
business object represents a PeopleSoft Collection that can contain multiple
Records. The type of the attribute is the same as the type of the array of child
business objects.

The connector assumes that every hierarchical business object represents a single
PeopleSoft Component Interface. Although a hierarchical business object may
represent data in multiple PeopleSoft Records, the connector assumes that each
child business object in the hierarchy represents a single Collection within the
Component Interface. The connector uses PeopleSoft’'s Component architecture and
processing (rather than the underlying database) to take advantage of the business
logic defined at the Component level.

When you define a business object, the following situations are possible:

* The Collection might have more fields than the corresponding individual
business object has simple attributes (that is, some fields in the Collection are
not represented in the business object). Include in your design only those fields
needed for the business object processing.

* The individual business object might have more simple attributes than the
corresponding Collection has fields (that is, some attributes in the business
object are not represented in the Collection). The attributes that do not have a
representation in the Collection either have no application-specific information
or are set with a default value.

Component interface and business object relationship

Because the connector requires a PeopleSoft Business Component and Component
Interface for each business object that it processes, and because the WebSphere
business integration system does not provide Business Components, Component
Interfaces, or PeopleSoft-specific business objects, you must create these objects to
use the connector.

Note: For portability, keep all your connector development in one PeopleSoft
Project.

After creating the required objects mentioned above, you can use Application
Designer to create the class structure required for the connector to process its
surported business objects. For more information, see|“Generating APIs” on pagé
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To assist you in creating these objects, this section includes:

* [“Example Component and Component Interface” on page 29

« |“Example business object” on page 32|

* |“Creating a business object” on page 32|

gure 6|illustrates a simple Component, EMER_CONTACT, which has two Pages and
three Records. The illustrated page, PERSONAL_DATA_PANEL1, stores emergency
contact information for each employee.

Example Component and Component Interface

PS.Page

Personal Data ]Joblnfu]

PERSONAL _DATA
EMPLID: 001 Hame: John Doe Level O ' EMPLID HAME ADDRESS
a1 John Doe ST Ar...

Emergency Contact Info
oz Suzan Smith | 25 Camilla...

Hame: |.Jennifer Doe E
Address:|1 881 Broadway Blvd EMERGENCY _CHTCT
- - EMPLID CONTACT_HAME ADDRESS
City: [Burlinoame =
e I 4 >_ Level1 oot Jenriter Dae 1581 Broadway .|
State: |California = zip: 94109 | (50!—:0u; 002 | Jim Smith 44 Sepulveda...
Level 1) 002 | Melissa Smith 717 Pacific
Emergency Contact Phope('s)
: (Scrall EMERGENCY_PHONE
Type.| Home Bd evel 2)| Level 2 —
EMPLID CONTACT_HAME | PHOHNE_TYPE PHOHE
Humber: I 560-888-6754 [ilt]] Jennifer Doe Home 550-565-6754
E _.// oot Jenniter Dog Wiork 425-995-46575
| FERSONAL_DATA_PANEL1 o0z Jim Stuith Home 702-415-9768
ooz Melizza Smith Home 914-413-9768

Figure 6. Example component

The above graphic illustrates the relationship between data displayed at each level
of the personal data Page and the corresponding Record that stores it:

* Level 0 data is stored in the PERSONAL_DATA Record, whose key field is EMPLID.

* Level 1 data is stored in the EMERGENCY_CNTCT Record. Because each employee
can have more than one emergency contact, each contact is uniquely identified
by name (CONTACT_NAME), as well as by the employee’s ID (EMPLID). The Scroll in
Level 1 allows you to display data in the entire contact Collection.

* Level 2 data is stored in the EMERGENCY PHONE Record. Because each contact can
have more than one phone, each phone number is uniquely identified by type
(PHONE_TYPE), as well as by the contact’s name (CONTACT_NAME) and the
employee’s ID (EMPLID). The Scroll in Level 2 allows you to display data in the
entire phone Collection.

As the EMERGENCY_CNTCT and EMERGENCY_PHONE Records illustrate, each Record’s key
is a composite that includes its parent’s key as well as its own unique identifier.

Not all Components represent data records in the same straightforward manner as
the example. For instance, scroll levels do not always correspond to separate
Records or child Records. Sometimes a Component uses derived or work Records;
sometimes it embeds related display Records; sometimes it uses the same Record
to represent data on several of its levels. In these situations, the design of the
Component Interface is much more sophisticated than the example, and requires
serious consideration of the processing needs.
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When working with a complex Component, consider the following areas when
designing:

:

* |“Hidden Fields”|

“Read-Only Fields’]

Levels: When designing a Component’s levels, consider the following:

* Verify that the Component Interface behaves like the online Pages contained in
the Component that it represents. You may need to modify the structure of
Component Interface properties and Collections, or add user-defined methods,
to ensure that the connector behaves as designed.

* Keys are exposed only at the first level in which they appear. Remove keys from
the top-level Collection of the Component Interface that do not appear at the
level-0 Scroll in the page. Manually add those keys that appear on the level-1
Scroll, in the Page definition, to the level-two Collection.

For example, assume you have a Page that uses three keys from the same
Record (such as SETID, DEPTID, and EFFDT). Assume further that this Page
uses EFFDT at Scroll Level 1 to return historical data for the given SETID and
DEPTID. When you create a Component Interface that contains this Page, it
displays all three keys in Collection Level 0 because all key fields exist in the
same Level-0 primary Record. If you want to use this Component Interface to
return a set of rows with EFFDT as the key, manually remove EFFDT from the
Level-0 Collection and add it to the Level-1 Collection. Doing so causes the
Component Interface to behave the same way as it does online.

* Examine the Page definitions of each Component, paying particular attention to
the order of elements on a Page. Verify the Scroll level at which each field
appears. Use this information to determine whether corresponding business
object attributes are at the correct level, or whether they belong in a child
business object.

Hidden Fields: Hidden fields are not always loaded into the Component
Processor. Exposing these fields might cause application service errors. It is not
recommended that you expose anything to the connector that is not visually
exposed on the Page.

Read-Only Fields: Fields marked as Read-Only on the Component Interface are
accessible to the connector, but only by the method that returns values. The
connector cannot set values in these fields. Therefore, specify the

get=FieldName parameter in the corresponding attribute’s application specific text,
but leave the set=FieldName parameter empty. Specifying the set parameter in such
a case causes an error if the method is triggered by an update or create operation.

For more information, see [“Application-specific information at the attribute level”|

ﬂlustrates the example Component Interface (EMER_CONTACT_PROFILE) that
contains the EMER_CONTACT Component.
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Figure 7. Example component interface

The three broad arrows in the left margin point to the tables (PERSONAL_DATA,
EMERGENCY_CNTCT, and EMERGENCY_PHONE) that store data for the Component
Interface. The two narrow arrows point to the key icons that indicate the key fields
(EMPLID and CONTACT_NAME) of the EMERGENCY_CNTCT table.

PeopleSoft designed Component Interfaces to expose desired elements of a
Component to third parties, making the business process logic (such as the
PeopleCode, Field Edits, and PeopleSoft Security) transparent to external
integration applications. Therefore, the connector relies on the application for any
processing between the Component Interface and the database.

This dependency causes certain limitations, such as the lack of Search dialog
processing. Consequently, the SearchInit, SearchSave, and RowSelect events are
never triggered, and any PeopleCode associated with them does not run. This
limitation also extends to any PeopleCode events that are exclusively related to
GUI or online processing, including Menu PeopleCode and pop-up menus.

Therefore, before you create a Component Interface for the connector, verify that
no important behavior will be lost, and that all predetermined data is in place
before the connector accesses it. You can implement some of this skipped behavior
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as user-defined methods in the Component Interface or as Component-specific
PeopleCode (such as the Pre-Build event). Failure to take these precautions can
cause runtime errors.

To enable the connector to process the data represented by the
EMER_CONTACT_PROFILE Component Interface, you must create PeopleSoft-specific
business objects in the WebSphere business integration system.

Example business object

ﬂlustrates a hierarchical PeopleSoft-specific business object that you can
create in the WebSphere business integration system to represent the example
Component Interface.

PSFT_Emer gencyContact PSFT_EmergencyPhone
verb verb
Empld
Empld ContactName
ContactName PhoneTy pe
Deptld
EmergencyPhone[n]

Figure 8. Example business objects

The PSFT_EmergencyContact business object contains two simple attributes that
represent the key field data: EmpId and ContactName. These attributes correspond to
EMPLID and CONTACT_NAME in the EMERGENCY_CNTCT Record. PSFT_EmergencyContact
also has an array attribute (EmergencyPhone[n]) that represents the array of
PSFT_EmergencyPhone business objects.

The PSFT_EmergencyPhone business object contains three simple attributes that
represent the key field data: EmpId, ContactName, and PhoneType. The first two
attributes serve as keys, uniquely identifying the parent business object. The third
attribute uniquely distinguishes the child from other business objects in the same
array.

Creating a business object

To create a supported business object, perform the following steps:

1. Locate the Component that represents the event and transaction. If necessary,
create one.

2. Use the PeopleSoft Application Designer to create a Component Interface from
the Component in step 1.

3. Use PeopleSoftODA or Business Object Designer Express to create a
corresponding PeopleSoft-specific business object. For more information about
business objects, see|[“Business object attribute properties” on page 43| and
[“Business object application-specific information” on page 45 For more
information about PeopleSoftODA, see |Chapter 4, “Generating business object|
[definitions using PeopleSoftODA,” on page 51

4. Add the PeopleSoft-specific business object to the list of the connector’s
supported business objects. For business-object subscription information specific
to InterChange Server Express, see the broker’s implementation guide.

32 Adapter for PeopleSoft User Guide



Use the PeopleSoft Application Designer to create a class structure from a
Component Interface. The business object that corresponds to the Component
Interface requires these classes to process the data; it is part of the PeopleSoft APL

To assist you in creating and using the generated classes, this section covers:

+ |[“Generating APIs” on page 33|

* |“Example APIs” on page 33|

Generating APIs
To generate APIs from a Component Interface, do the following:
1. Open the Component Interface in the Application Designer.
2. Select the PeopleSoft APIs menu from the Build menu.
3. Select only the Java option, specifying the destination as:

Windows
%ProductDir%\connectors\PeopleSoft\dependencies

| End of Windows

4. Compile the generated classes and verify that they are in the following
directories:

%ProductDirS% directory:

Component Interface class files
\connectors\PeopleSoft\dependencies\PeopleSoft\Generated\CompIntfc

Session-specific class files
\connectors\PeopleSoft\dependencies\PeopleSoft\Generated\PeopleSoft

For a more detailed explanation of the API-generating process, including screen
shots, see [“Building the API files” on page 16|

Example APIs

If you use the PeopleSoft APIs menu (a submenu of the Build menu) to create a
class structure from the example EMER_CONTACT_PROFILE Component Interface, you
have the following:

* EmerContactProfile.class—corresponds to the Component Interface

The connector uses the name of this class to retrieve and instantiate the
Component Interface in PeopleSoft. The classname is stored in the CiName
property in the application-specific information at the business object level. For
more information, see [ Application-specific information at the business object|
[level” on page 45|

e EmerContactProfileEmergencyCntct.class—corresponds to the EMERGENCY_CNTCT
Collection.

* EmerContactProfileEmergencyCntctEmergencyPhone.class—corresponds to the
EMERGENCY_PHONE Collection.

The generated methods that the connector uses are:
* |“getFieldName() Method” on page 3
* [’setFieldName() Method” on page 34
+ [“getCollectionName() Method” on page 34|
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* |"Currentltem() Method” on page 34|
¢ |"Item(index) Method” on page 35|

getFieldName() Method

Each of the generated classes contains the getFieldName () method, which enables
the connector to get the data value of each simple field of the Component
Interface, and load it into the corresponding business object attribute.

For example, as illustrated in the right half of there are seven fields listed
as FINDKEYS for the EMER_CONTACT_PROFILE Component. These fields include EMPLID,
NAME, and DEPTID. To get data from these fields, the connector uses the getEmpId(),
getName(), and getDeptId() methods. After obtaining the values, the connector
loads them into the EmpId, ContactName, and DeptId business object attributes.

To return the value of simple fields in a Collection, the connector first returns the
Collection, and then returns the fields in it. For example, to get the values in the
CONTACT_NAME and SAME_ADDRESS_EMPL fields of the EMERGENCY_CNTCT Collection, the
connector first executes the getEmergencyCntct() method. Then it executes the
getContactName() and getSameAddressEmpl() methods. For more information, see
I“eetCollectionName() Method” on page 34

setFieldName() Method

Each of the generated classes contains the setFieldName () method, which enables
the connector to set the data value of each simple field of the Component Interface
based on the value of its corresponding business object attribute.

For example, to load data from the EmpId, ContactName, and DeptId business object
attributes into the EMPLID, NAME, and DEPTID fields, the connector uses the
setEmpId(), setName(), and setDeptId() methods.

getCollectionName() Method

To return the Collection of emergency contacts for a given employee, the connector

uses the getEmergencyCntct () method in the EmerContactProfile class. The way

that the connector handles the multiple rows depends on the setting of

application-specific information at the business-object level.

 If the EFFDT parameter evaluates to true, the connector uses the CurrentItem()
method to return only the record with the latest effective date.

 If the EFFDT parameter evaluates to false, the connector uses the Item(index)
method to return only the first record, regardless of the effective date. For
example, the connector returns a future date, if one is listed.

For information about the EFFDT parameter, see [“Application-specific information at
lthe business object level” on page 45,

To return the Collection of phone types and phone numbers for each of an
employee’s emergency contacts, the connector uses the getEmergencyPhone()
method in the EmerContactProfileEmergencyCntct class. After obtaining all
Records, the connector loads them into the business object’s array attribute,
EmergencyPhone[n].

Currentltem() Method

When retrieving the records in a Collection, the connector uses the CurrentItem()
method in the EmerContactProfile class to return only the record with the latest
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effective date. The connector uses this method only if the EFFDT parameter of the
business-object level application-specific information evaluates to true.

Item(index) Method

When retrieving the records in a Collection, to return only the record with the
specified record number, the connector uses the Item(index) method in the
EmerContactProfile class. The connector uses this method only if the EFFDT
parameter of the business-object level application-specific information evaluates to
false. By default, this method returns the first row retrieved.

Business object verb processing

This section describes the following aspects of processing a business object’s verbs:

“Afterimages and deltas” on page 35, which defines the terms and explains how
the connector works with afterimages.

* [“Verb Processing for business object requests” on page 37} which explains the
steps the connector takes when creating, retrieving, updating, or deleting a
business object.

+ [“Committing data” on page 43, which briefly explains how the connector saves
data.

Afterimages and deltas

An afterimage is the state of a business object after all changes have been made to
it. A delta is a business object used in an update operation that contains only key
values and the data to be changed. This connector supports only afterimages, not
business object deltas. When the connector receives a request business object for
update, it assumes that the business object represents the desired state of the data
after update.

Therefore, when the connector receives a request business object with the Update
verb, it changes the current representation of the business object in the Component
Interface so that it exactly matches the source business object. To do this, the
connector changes simple attribute values and adds or removes child business
objects.

For an example of how the connector modifies child business objects, assume that
the PSFT_EmergencyContact business object has two additional attributes, one of
which represents a single-cardinality child and the other of which represents an
array of child business objects. Each child of the array can contain its own array of
child business objects.

illustrates the current state of PSFT_EmergencyContact for an employee

whose ID is 2345. The ArrayData attribute represents three Records (A, B, and C).
The array attribute in two of these records represents two additional Records.

Chapter 3. Understanding business objects for the connector 35



—— —p-PSFT_EmergencyPhone

PSFT_EmergencyContact |
Empld=2345
ContactName |
DeptID
EmergencyPhone[n] —— J r -»| D
SingleDatal[ 1
g [1] | E
ArrayData[n] —— — —— —— g
B 1
— p| F
G

Figure 9. State of data prior to update

illustrates a business object request. This business object contains a new
single-cardinality child business object and contains different business objects in its
arrays.

PSFT_EmergencyContact PSFT_EmergencyPhone

Update

ContactName

DeptID
EmergencyPhone[n] —+ |
SingleData[1] — — —
ArrayData[n] — — — p»| F

Empld=2345 | PSFT_SingleData
—_— — — — >
| T

- — -

C

Figure 10. Data represented by an update request

To process the update, the connector applies the following changes to the
Component Interface:

» Updates the simple attributes in the PSFT_EmergencyContact and the
PSFT_EmergencyPhone business objects.

* Creates the PSFT_SingleData business object.

* Updates the simple attributes in the child business objects A, B, F and G.
¢ Deletes the child business objects C, D and E.

* Creates the child business objects H, I and J.
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Because the connector assumes that each request business object it receives
represents an afterimage, it is important that each business object sent to the
connector for updating contains all valid existing child business objects. Even if
none of a child business object’s simple attributes have changed, the child business
object must be included in the source business object.

There is a way, however, that you can prevent the connector from deleting missing
child business objects during an update operation. To instruct the connector to
keep child business objects that are not included in the source business object, use
the application-specific information for the attribute that represents the child or
array of children. To do so, set KeepRelationship to true. For more information,
see [“Application-specific information at the attribute level” on page 47

Verb Processing for business object requests

This section outlines the steps the connector takes when creating, retrieving,
updating, or deleting a business object that it receives as a request. The connector
processes hierarchical business objects recursively; that is, it performs the same
steps for each child business object until it has processed all individual business
objects.

Business object comparison

At various points in the processing outlined below, the connector compares two
business objects to see if they are the same. For example, during an update
operation, the connector determines whether a particular business object exists in
an array of business objects. To perform the check, the connector compares the
business object to each business object within the array. For two business objects to
be identical, the following two conditions must be satisfied:

* The type of the business objects being compared must be the same. For example,
a PSFT_Customer business object is never considered identical to a PSFT_Contact
business object even if all of their attributes are exactly the same.

* All corresponding key attributes in the two business objects must contain
identical values. If a key attribute is set to CxIgnore in both business objects, the
connector considers them identical. However, if a key attribute is set to CxIgnore
in one business object but not in the other, the business objects are not identical.

Create operations

When creating a business object, the connector returns a status of either
VALCHANGE if the operation was successful (regardless of whether the operation
caused changes to the business object), or FAIL if the operation failed.

The connector performs the following steps when creating a hierarchical business

object:

1. Creates a new instance of a Component Interface for the top-level business
object.

* Uses PeopleSoft’s SetFieldName (value) method to populate properties in the
Component Interface with values from attributes in the business object.

Important: If the UID parameter of a key attribute’s application-specific
information evaluates to false, the business process that creates
the business object must provide a new unique ID value for the
attribute. If the business object does not have the required value,
the connector logs an error.

If the UID parameter of a key attribute’s application-specific
information evaluates to true, the application is responsible for
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generating a unique ID. In this case, the attribute’s value or the
Default Value property must contain the string NEXT. In other
words, if the business process that creates the business object
does not populate its value as NEXT, this value must be specified
in the attribute’s Default Value property. If the business object
uses the Default Value property to provide the String NEXT, the
connector’s UseDefaults property must evaluate to true. For
more information, see|[“UseDefaults” on page 22}

If a unique identifier is not provided for the attribute’s value,
and the string NEXT is not specified in the Default Value
property, the application logs a duplicate-key error.

* Verifies that all Required attributes contain a value, and throws an error if
such a value is missing. For more information on Required attributes, see

[“Required property” on page 43|

2. Recursively inserts each child business object and each array of child business
objects into the Component Interface. In other words, the connector creates the
child and all child business objects that the child and its children contain.

Note: If the business object definition for an attribute that represents a
single-cardinality child business object specifies that the child is required
(that is, its Required property evaluates to true), the retrieval must
return a row. If it does not return a row, the connector returns an error
and stops processing. However, if the child is not required and the
attribute is empty, the connector ignores the attribute.

3. The connector calls the Save() method, which writes and commits the data.

* If the connector is generating the unique ID, the generation occurs as this
method executes.

e If the application is generating the unique ID, the connector retrieves the key
values set by the application after this method executes.

Note: Because InterChange Server Express is the integration broker, the ID

must be delivered synchronously because InterChange Server Express
requires the ID to cross-reference the business object.

* If setInteractiveMode is defined as false in the business object’s
application-specific information, all PeopleCode editing occurs at this point.
Any PeopleCode errors are published to the PSMessage collection queue.

¢ If an instance of the Component Interface already exists with the same key
values, the application returns a duplicate-key error, and the connector sends
the FAIL return code.

For more information on attribute properties, see [“Business object attributé]

|properties” on page 43| For more information on specifying application-specific

information, see [“Application-specific information at the attribute level” on pagel

Retrieve operations

When retrieving a business object, the connector returns a status either of
VALCHANGE if the operation was successful (regardless of whether the operation
caused changes to the business object), or FAIL if the operation failed.

The connector performs the following steps when retrieving a hierarchical business

object:
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Removes all child business objects from the top-level business object that it
received from InterChange Server Express.

Retrieves the Component Interface that corresponds to the top-level business
object.

The connector uses the key values in the source business object to instantiate
the Component Interface. The result of the retrieval causes one of the following
actions:

 If it finds a Component Interface instance, the connector continues
processing.

e If it does not find a Component Interface instance, indicating that the
top-level business object does not have a corresponding Component Interface
in the application, the connector returns FAIL.

e If it finds multiple Component Interface instances, the connector returns
MULTIPLE_HITS.

Note: A business object can contain attributes that do not correspond to any
Component Interface property. During retrieval, the connector does not
change such attributes in the top-level business object; they remain set to
the values it received. For child business objects, the connector sets such
attributes to their default values during retrieval.

Recursively retrieves all Collections of the Component Interface that correspond
to business object arrays.

The connector uses the keys in each parent business object and the unique key
of each child to select a data row from the Component Interface instance or
Component Interface Collection. For each row returned, the connector performs
the following actions:

a. Creates a new individual business object of the correct type.

b. Sets all of the current business object’s attributes based on the values in the
returned row.

C. Recursively retrieves all of the current business object’s children.

d. Inserts the current business object with all of its children into the
appropriate array of the parent.

Note: The connector does not enforce uniqueness when populating an array of
business objects. It is the application’s responsibility to ensure
uniqueness. If the application returns duplicate child business objects,
the connector returns duplicate children to InterChange Server Express.

Recursively retrieves the Collections for each of the top-level business object’s
single-cardinality children. The connector uses the keys in each parent business
object and the unique key of each child to select a data row from the
Component Interface instance or Component Interface Collection. The
connector performs the following:

a. If the business object’s definition specifies that the child is required, the
retrieval must return a row. If the child is not required and the retrieval
returns no rows, indicating that the child does not exist in the Component
Interface, the connector leaves the parent’s single-cardinality attribute
empty. If the retrieval returns more than one row, the retrieval fails.

b. Recursively retrieves the Collections for all children contained by the child
business object.

c. Inserts the business object with all of its children into the appropriate
attribute in the parent business object.
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RetrieveByContent operations

When retrieving a business object, the connector returns a status of VALCHANGE if
the operation was successful (regardless of whether the operation caused changes
to the business object), FAIL if the operation failed, or MULTIPLE_HITS if the
operation returned more than one row.

The connector performs the following steps when retrieving a hierarchical business

object:

1. Removes all child business objects from the top-level business object that it
received from InterChange Server Express.

2. Retrieves the Component Interface that corresponds to the top-level business
object.

The connector uses the values of those attributes that are find keys in the
source business object to instantiate the Component Interface. (For more
information about specifying application-specific information for find key
attributes, see|”Application-specific information at the attribute level” on pagel
The result of the retrieval causes one of the following actions:

 If it finds a Component Interface instance, the connector continues
processing.

e If it does not find a Component Interface instance, indicating that the
top-level business object does not have a corresponding Component Interface
in the application, the connector returns FAIL.

* If it finds multiple Component Interface instances, the connector returns
MULTIPLE_HITS.

Note: A business object can contain attributes that do not correspond to any
Component Interface property. During retrieval, the connector does not
change such attributes in the top-level business object; they remain set to
the values it received. For child business objects, the connector sets such
attributes to their default values during retrieval.

3. Recursively retrieves all Collections of the Component Interface that correspond
to business object arrays.

The connector uses the keys in each parent business object and the unique key
of each child to select a data row from the Component Interface instance or
Component Interface Collection. For each row returned, the connector performs
the following actions:

a. Creates a new individual business object of the correct type.

b. Sets all of the current business object’s attributes based on the values in the
returned row.

C. Recursively retrieves all of the current business object’s children.

d. Inserts the current business object with all of its children into the
appropriate array of the parent.

Note: The connector does not enforce uniqueness when populating an array of
business objects. It is the application’s responsibility to ensure
uniqueness. If the application returns duplicate child business objects,
the connector returns duplicate children to InterChange Server Express.

4. Recursively retrieves the Collections for each of the top-level business object’s
single-cardinality children. The connector uses the keys in each parent business
object and the unique key of each child to select a data row from the
Component Interface instance or Component Interface Collection. The
connector performs the following;:
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a. If the business object’s definition specifies that the child is required, the
retrieval must return a row. If the child is not required and the retrieval
returns no rows, indicating that the child does not exist in the Component
Interface, the connector leaves the parent’s single-cardinality attribute
empty. If the retrieval returns more than one row, the retrieval fails.

b. Recursively retrieves the Collections for all children contained by the child
business object.

c. Inserts the business object with all of its children into the appropriate
attribute in the parent business object.

Update operations
When updating a business object, the connector returns a status of either VALCHANGE
if the operation was successful (regardless of whether the operation caused
changes to the business object), or FAIL if the operation failed.

The connector performs the following steps when updating a hierarchical business
object:

1.

Uses the key values of the source business object to retrieve the corresponding
Component Interface instance. The retrieved Component Interface is an
accurate representation of the current state of the data in the PeopleSoft
application.

* If the retrieval fails, indicating that the top-level business object does not
exist in the application, the connector returns BO_DOES_NOT_EXIST.

¢ If the retrieval succeeds, the connector compares the retrieved Component
Interface to the source business object to determine which child business
objects require changes in the Component Interface. The connector does not,
however, compare values in the source business object’s simple attributes to
those in the retrieved Component Interface; the connector updates the value
of all simple attributes.

Recursively updates all single-cardinality children of the top-level business
object.

If the business object definition requires that an attribute contain a child
business object, the child must exist in both the source business object and the
retrieved Component Interface. If it does not, the update fails, and the
connector returns an error.

The connector processes the update of single-cardinality child business objects
in one of the following ways:

¢ If the child is present in both the source business object and the retrieved
Component Interface, the connector recursively updates it in the Component
Interface.

Note: The source business object and the retrieved Component Interface
must match. If the two hierarchical objects contain the same
single-cardinality ownership children in different order, the connector
returns an error and stops processing.

* If the child is present in the source business object but not in the retrieved
Component Interface, the connector recursively creates it in the Component
Interface.

Important: If the UID parameter of a key attribute’s application-specific
information evaluates to false, the business process that creates
the business object must provide a new unique ID value for the
attribute. If the business object does not have the required value,
the connector logs an error.
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If the UID parameter of a key attribute’s application-specific
information evaluates to true, the application is responsible for
generating a unique ID. In this case, the attribute’s value or the
Default Value property must contain the string NEXT. In other
words, if the business process that creates the business object
does not populate its value as NEXT, this value must be specified
in the attribute’s Default Value property. If the business object
uses the Default Value property to provide the String NEXT, the
connector’s UseDefaults property must evaluate to true. For
more information, see [“UseDefaults” on page 22}

If a unique identifier is not provided for the attribute’s value,
and the string NEXT is not specified in the Default Value
property, the application logs a duplicate-key error.

e If the child is present in the retrieved Component Interface but not in the
source business object, the connector recursively deletes it from the
Component Interface. However, if the KeepRelationship parameter of the
parent’s application-specific information evaluates to true, the connector
preserves the child business object.

When deleting child business objects during an Update operation, the
connector uses PeopleSoft’s deleteItem() method to delete the
corresponding Collection from the Component Interface instance. The
connector physically or logically deletes only Collections that are at level 1 or
higher.

For more information on specifying application-specific information, see
[“ Application-specific information at the attribute level” on page 47]

3. Updates all simple attributes of the retrieved Component Interface except those
whose corresponding attribute in the source business object contain the value
CxIgnore.

4. Processes all arrays of the retrieved Component Interface in one of the
following ways:

* If a child exists in both the source business object’s array and the retrieved
Component Interface’s array, the connector recursively updates it in the
Component Interface.

* If a child exists in the source array but not in the retrieved Component
Interface’s array, the connector recursively creates it in the Component
Interface.

e If the child exists in the retrieved Component Interface’s array but not in the
source array, the connector recursively deletes it from the Component
Interface.

Important: The business process that creates the business object must ensure
that multiple-cardinality business objects in the source business
object are unique (that is, that an array does not contain two or
more copies of the same business object). If the connector receives
duplicates of a business object in a source array, it processes the
business object twice, with possibly unpredictable results.

Note: The connector locks data while retrieving it to ensure data integrity.
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Delete operations

The connector does not delete a top-level business object. However, it does
physically delete a child business object if its top-level business object uses the
Update verb, and the child does not exist in the request business object that
represents source data.

For more information, see [“Update operations” on page 41|

Committing data

Whenever the connector receives a business object for create or update processing,
it either saves all changes to the Component Interface or none. The connector
never saves subset of data changes.

Business object attribute properties

Business object architecture defines various properties that apply to attributes. This
section describes how the connector interprets several of these properties and
describes how to set them.

Name property

Each business object attribute must have a unique name.

Type property
Each business object attribute must have a type, such as Integer, String or the
type of a child business object.

Cardinality property

Each business object attribute that represents a child or array of child business
objects has the value of 1 or n, respectively, in this attribute. All attributes that
represent child business objects also have a ContainedObjectVersion property
(which specifies the child’s version number) and a Relationship property (which
specifies the value Containment).

Key property
At least one simple attribute of each business object must be specified as the key.
To do so, set this property to true.

Note: The connector does not support specifying an attribute that represents a
child business object or an array of child business objects as a key attribute.

The connector uses each key attribute to uniquely identify or create an instance of
a Component Interface. For information about causing the application to generate a
ilique ID, see |”Create operations” on page 37| and |”Update operations” on page|

Required property
The Required property specifies whether a simple attribute or an attribute that
represents a single-cardinality child business object must contain a value.

If this property is specified for an attribute that represents a single-cardinality child

business object, the connector requires the parent business object to contain a child
business object for this attribute.
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When the connector receives a business object with a Create request, the connector
causes the Create operation to fail if a required attribute does not have a valid
value.

When the connector receives a business object with a Retrieve request and the
business object does not have a valid value or a default value for a required
attribute, the connector causes the retrieval operation to fail.

The connector does not use this property for attributes that represent an array of
child business objects.

Max length property

If the attribute is of type String, this property specifies the maximum length
allowed for the attribute’s value.

AppSpecificlnfo

For information on this property, see |“Application-specific information at thel
lttribute level” on page 47

Default value property

This property specifies a default value that the connector uses to populate a simple
field if the attribute does not contain a value. The connector does not evaluate this
property for attributes that represent child business objects. For a create operation,
the connector uses the value of this property only if its UseDefaults property
evaluates to true. For more information, see|“UseDefaults” on page 22|

The connector sends the value of this property to the application to use in
identifier-generation if the following is true:

¢ The Default Value property is specified for a key attribute whose
application-specific information specifies true in its UID parameter

* The value of the Default Value property is the string NEXT
e The connector’s UseDefaults property evaluates to true

For information about causing the application to generate a unique ID, see
foperations” on page 37| and |“Update operations” on page 41}

Special attribute value

Simple attributes in business object can have a special value: CxIgnore. When the
connector receives a request business object, the connector ignores all attributes
with a value of CxIgnore. It is as if those attributes were invisible to the connector.

When the connector retrieves data from a Component Interface with a field that
contains a null value, the connector sets the value of its corresponding attribute to
CxIgnore by default.

Because the connector requires at least one key attribute to create a business object,
the business process that creates the business object should ensure that business
objects passed to the connector have at least one key that is not set to CxIgnore.
The only exception to this requirement is a business object whose key is to be
generated by the connector.
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Business object application-specific information

Application-specific information in business object definitions provides the
connector with application-dependent instructions on how to process business
objects. The connector parses the application-specific information from the
attributes or verb of a business object or from the business object itself to generate
queries for Create, Update, Retrieve, and Delete operations.

The connector stores some of the business object’s application-specific information
in cache and uses this information to build queries for all the verbs.

If you extend or modify an application-specific business object, you must make
sure that the application-specific information in the business object definition
matches the syntax that the connector expects.

This section provides information on the application-specific information format
for business objects supported by the connector.

provides an overview of the functionality available in business object
application-specific information.

Table 6. Overview of application-specific information in supported business objects

Scope of application-specific
information Functionality
Entire business object Specifies:
* The name of the corresponding Component Interface

* Whether triggering of online Field PeopleCode edits is immediate
or batch

* Whether all rows associated with component interface are
retrieved or only the most recent instance
Simple attributes Specifies:
* Whether the application generates unique identifier values or
whether the connector provides them
* Whether an attribute should be used as a key for retrieving data
Business object verb The connector does not specify functionality based on the verb.

The following sections discuss this functionality in more detail.

Application-specific information at the business object level
Application-specific information at the business-object level allows you to:
* Specify the name of the corresponding Component Interface.

* Define whether online Field PeopleCode triggers immediately after update or
during save() method

* Indicate whether or not all rows from a Component Interface are retrieved
regardless of effective date.

At the business-object level, application-specific information format consists of four
parameters separated by a colon (:) delimiter. The format is:

cIName=<ComponentInterface>

:EFFDT=[true|false] :setInteractiveMode=[true|false] :GetHistoryItems
=[true|false] :setEditHistoryItems=[true|false]
:GetDummyRows=[true|false] : InsAtOldestEffDtPos=[true]
:InsAtCurrentEffDtPos=[true]
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describes these parameters.

Table 7. AppSpecificinfo at the business-object level

AppSpecificinfo parameter

cIName

EFFDT (isEffectiveDated)

setInteractiveMode

GetHistorylItems

GetDummyRows

InsAtOldestEffDtPos

InsAtCurrentEffDtPos

SetEditHistoryItems

Description

Specifies the name of the Component Interface defined in the
PeopleSoft application.

Specifies whether the business object (or child business
object) uses an Effective Date:

* If the EFFDT parameter evaluates to true, the connector
uses the CurrentItem() method to return only the record
with the latest effective date.

* If the EFFDT parameter evaluates to false, the connector
uses the Item(index) method to return only the first
record, regardless of the effective date. For example, the
connector returns a future date, if one is listed.

The default value is true.

Determines when the connector sends changes to the
Application Server. This property is typically used to
enhance performance.

* When set to true, the connector processes each time the
value of a property or attribute changes; in other words,
all online Field PeopleCode immediately triggers after the
connector calls setPropertyName () on each attribute.

* When set to false, the PeopleSoft application batches the
processing, sending changes to the Application Server only
when the connector calls Save() on a Component
Interface.

The default value is true.
Determines how much data the connector retrieves.

¢ When set to true, the connector retrieves all data rows,
regardless of effective date, for the corresponding
Component Interface.

* When set to false, the connector retrieves only the current
data (the effective row).

The default value is true.

Supports the GetDummyRowsproperty in PeopleTools 8.4 and
higher. Do not set this if you are using older versions of
PeopleTools. For information about this property, see your
PeopleSoft documentation.

This parameter is provided to address limitations in older
versions of PeopleTools where the call
getEffectiveItemNum()returns an insert position of -1 for
effective-dated rows. When InsAtOTdestEffDtPos is set, the
connector inserts the row at the highest index, which has the
oldest effective date. If you set this parameter, do not set
InsAtCurrentEffDtPos.

This parameter is provided to address limitations in older
versions of PeopleTools where the call
getEffectiveltemNum()returns an insert position of -1 for
effective-dated rows. When InsAtCurrentEffDtPos is set, the
connector inserts the row at the lowest index zero, which has
the current effective date. If you set this parameter, do not
set InsAtOldestEffDtPos.

Enables editing and saving of history data. Applies to
effective-dated fields only.

For more information about the setInteractiveMode and GetHistoryItems
properties, see the documentation from PeopleSoft.
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For example, the PSFT_EmergencyContact business object might have the
following value specified for its business object application-specific information:

cINAME=EMER_CONTACT_PROFILE:setInteractiveMode=false:
GetHistoryItems=true:isEffectiveDated=false

Application-specific information at the attribute level

Application-specific information at the attribute level specifies the connector’s
behavior on an attribute-by-attribute level. The format of the application-specific
information is a set of five name-value parameters, each of which includes the
parameter name and its value. Each parameter set is separated from the next by a
colon (:) delimiter. A vertical bar (1) separates the members of a set of options. The
format is:

get=getFieldName:set=setFieldName:UID=[true|false] :GetKey=[true|false] :KeepRelationship
=[true|false]: findKey=[true|false] :bigDec=true:EFFDT=[true|false]
:EFFDTSEQ=[true|false]

Important: Case is significant when the connector evaluates application-specific
information.

For example, for a Read-Only simple attribute that should be used in addition to
the key fields when retrieving data, you might specify the following format:
get=getBusinessUnit:GetKey=true

For a multiple-cardinality attribute whose children should be preserved even if
they are not included in an Update business object request, you might specify the
following format:

get=getEmergencyPhone:set=setEmergencyPhone:KeepRelationship=true

able § describes each name-value parameter.

Table 8. Name-value parameters in attribute application-specific information

Parameter

get=getFieldName

set=setFieldName

Description

This parameter specifies the method to use when retrieving a value
from a Component Interface field or Component Interface Collection
to the current attribute.

This parameter specifies the method to use when setting a value in a
Component Interface field or Component Interface Collection, based
on the value in the current attribute.
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Table 8. Name-value parameters in attribute application-specific information (continued)

Parameter

UID=[true | false]

GetKey=[true | false]

Description

If this parameter is set to false, a unique value for the attribute must
be provided by the business process that creates the business object.
If the attribute does not contain a value, the connector sends an error
message.

If this parameter is set to true, the application is responsible for
generating a unique ID (using auto-numbering). Identifier generation
requires the attribute’s value to contain the String NEXT. The business
process that creates the business object must populate its value as
NEXT, or this value can be specified in the attribute’s Default Value
property. If the business object uses the Default Value property to
provide the String NEXT, the connector’s UseDefaults property must
evaluate to true. For more information, see|“UseDefaults” on page|

If the key value is set to anything other than varchar, and you want
the application to generate the IDs, leave the value blank and
UID=True. Only set the value to NEXT when the key value is set to a
varchar datatype.

When the application generates the unique ID, the connector
retrieves the generated ID from the application after the Save
operation completes and the data has been committed.

When InterChange Server Express is InterChange Server Express, the
connector uses the retrieved ID in cross-referencing the business
object.

If an attribute does not require the application to generate a unique
ID, set this value to false, or do not include this parameter in the
application-specific information.

If this parameter is set to true and the attribute’s Key and Required
properties evaluate to true, the connector includes the attribute as
part of the key during a retrieve or retrieve-for-update operation.

The connector uses this parameter to differentiate a retrieval key
from a create key when a distinction is necessary. When executing a
create operation, the connector provides as keys only those attributes
whose Key and Required properties evaluate to true. Because the
create-key fields alone do not always uniquely retrieve required data,
the connector adds to the keys all attributes whose GetKey parameter
evaluates to true when it executes a retrieve operation.
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Table 8. Name-value parameters in attribute application-specific information (continued)

Parameter

KeepRelationship=[true | false]

findKey=[true | false]

bigDec=[true | false]

EFFDT=[true | false]

EFFDTSEQ=[true | false]

Description

Used only on an attribute that represents an array of child business
objects, this parameter specifies whether the connector deletes
existing child business objects that are not represented in the source
business object during an update operation.

* Set to true to prevent deletion.
* Set to false to allow deletion.

For example, assume an existing phone number is associated with an
existing contact. Assume further that the connector receives a request
to update a PSFT_EmergencyContact business object that contains a
single child business object. The child associates an emergency phone
number with the contact. If KeepRelationship evaluates to true for
the EmergencyPhone[n] attribute, the connector updates the contact by
adding its new association without deleting its existing association.

However, if KeepRelationship evaluates to false, the connector
deletes all existing child data that is not contained in the source
business object. In such a case, the contact is associated only with the
new phone number.

If this parameter is set to true, the connector includes the attribute as
a key during a retrieve-by-content operation. Set this parameter for
attributes that are find keys in the Component Interface.

This parameter identifies bigdecimal type attributes. Set this
parameter to true for bigdecimal attributes in the Component
Interface.

This parameter identifies effective-dated attributes in the Component
Interface. The connector only uses this if, at the business object level,
application-specific information has EFFDT set to true.

This parameter identifies the sequence of effective-dated attributes
based on which insert position getEffectiveltemNum returns. The
connector only uses this if the business object definition includes an
effective-dated attribute.
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Chapter 4. Generating business object definitions using
PeopleSoftODA

This chapter describes PeopleSoftODA, an object discovery agent (ODA), that
generates business object definitions for the Adapter for PeopleSoft. Because the
connector works with objects that are based on PeopleSoft Component Interfaces
and their associated Collections, PeopleSoftODA uses the Component Interface
Java API to discover business object requirements specific to the PeopleSoft data
source.

This chapter contains the following sections:
* [“Installation and usa&”l
* [“Using PeopleSoftODA in Business Object Designer Express” on page 54

« |“Contents of the generated definition” on page 61|

+ |“Sample business object definition file” on page 64

* [“Modifying information in the business object definition” on page 69|

Installation and usage

This section discusses the following:

* |“Installing PeopleSoftODA"]

+ |“Before using PeopleSoftODA” on page 51|

* [“Launching PeopleSoftODA” on page 52|

¢ [“Running multiple instances of PeopleSoftODA” on page 53|

+ |“Working with error and trace message files” on page 53|

Installing PeopleSoftODA

To install PeopleSoftODA, use Installer for IBM WebSphere Business Integration
Server Express Plus Adapters. Follow the instructions in the Installation Guide for
WebSphere Business Integration Server Express. When the installation is complete, the
following files are installed in the product directory on your system:

* ODA\PeopleSoft\PeopleSoftODA.jar

* ODA\messages\PeopleSoftODAAgent.txt

¢ ODA\messages\PeopleSoftODAAgent_JI_TT.txt files (message files specific to a
language (_/l) and a country or territory (_TT))

* ODA\PeopleSoft\start_PeopleSoftODA.bat (Windows only)

Note: Except as otherwise noted, this document uses backslashes (\) as the
convention for directory paths. All product pathnames are relative to the
directory where product is installed on your system.

Before using PeopleSoftODA

Before you run PeopleSoftODA, verify that your system has the required files and
that the variables are correctly set in the script or batch file that runs the ODA.
This chapter assumes that you have already followed the instructions for installing
the connector. As part of the connector’s installation, you should have followed
instructions in the following sections:
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* |"Required software for using the connector” on page 11}—for information on
downloading psjoa.jar

* |“Enabling the application for the connector” on page 14—for information on
creating PSFTCI.jar

Therefore, you should find the following files in the
connectors\PeopleSoft\dependencies directory below the product directory:

* psjoa.jar—Downloaded from \web\PSJOA in the PS_HOME directory.
PeopleSoftODA uses this file to synchronously send Component Interfaces and
their information through the Jolt portion of the PeopleSoft Application Server.

e PSFTCI.jar—Created from Component Interface definitions in the Application
Designer. You must compile the Component Interface API files after you
generate them in PeopleSoft. PeopleSoftODA uses this file to generate business
object definitions. For more information, see ['Generating APIs” on page 33}

Important: It is recommended that you regenerate and recompile all component
interfaces prior to running PeopleSoftODA to assure consistency. If the
component interfaces are not in a jar file, or if either of the above jar
files are not in the correct directory, modify the start script or batch file
to locate them.

Open for editing the shell or batch file and confirm that the values described in
are correct.

Table 9. Shell and batch file configuration variables

Variable Explanation Example
set AGENTNAME Name of the ODA set AGENTNAME = PeopleSoftODA
set AGENT Name of the ODA’s jar ~ WINDOWS: set AGENT =
file %ProductDirS%\0DA\PeopleSoft\PeopleSoftODA.jar

Note: If you register PeopleSoftODA as a CORBA object or with an Object
Activation Daemon (OAD), you can modify the class path for the PeopleSoft
driver through the object discovery agent registration wizard. For
information on registering the ODA, see the Installation Guide for WebSphere
Business Integration Server Express.

After installing the PeopleSoft driver and setting configuration values in the shell
or batch file, you must do the following to generate business objects:

1. Launch the ODA.
2. Launch Business Object Designer Express.

3. Follow a six-step process in Business Object Designer Express to configure and
run the ODA.

The following sections describe these steps in detail.

Launching PeopleSoftODA

Launch the PeopleSoftODA with this script:

Windows
start_PeopleSoftODA.bat
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| End of Windows |

You configure and run PeopleSoftODA using Business Object Designer Express.
Business Object Designer Express locates each ODA by the name specified in the
AGENTNAME variable of each script or batch file. The default ODA name for this
connector is PeopleSoftODA. During installation, if you register the ODA with an
Object Activation Daemon, the wizard automatically prefixes the hostname to the
AGENTNAME value to make it unique.

Running multiple instances of PeopleSoftODA

It is recommended that you change the name of the ODA when you run multiple
instances of it. To create additional uniquely named instances of PeopleSoftODA:

* Create a separate script or batch file for each instance.
* Specify a unique name in the AGENTNAME variable of each script or batch file.

It is recommended that you prefix each name with the name of the host machine
when you run ODA instances on different machines. If you registered the ODA
with an Object Activation Daemon, you can use an ORB finder (osfind) to locate
existing CORBA object names on your network.

[Figure 11 on page 55|illustrates the window in Business Object Designer Express
from which you select the ODA to run.

Note: The connection properties must be the same for each particular ODA
instance. Each additional ODA instance must to connect to application
server instance to which it first connected.

Working with error and trace message files

Error and trace message files (the default is PeopTeSoftODAAgent.txt) are located in
\ODA\messages\, which is under the product directory. These files use the following
naming convention:

AgentNameAgent.txt

If you create multiple instances of the ODA script or batch file and provide a
unique name for each represented ODA, you can have a message file for each
ODA instance. Alternatively, you can have differently named ODAs use the same
message file. There are two ways to specify a valid message file:

* If you change the name of an ODA and do not create a message file for it, you
must change the name of the message file in Business Object Designer Express
as part of ODA configuration. Business Object Designer Express provides a
name for the message file but does not actually create the file. If the file
displayed as part of ODA configuration does not exist, change the value to point
to an existing file.

* You can copy the existing message file for a specific ODA, and modify it as
required. Business Object Designer Express assumes you name each file
according to the naming convention. For example, if the AGENTNAME variable
specifies PeopleSoft0ODAl, the tool assumes that the name of the associated
message file is PeopleSoftODAlAgent.txt. Therefore, when Business Object
Designer Express provides the filename for verification as part of ODA
configuration, the filename is based on the ODA name. Verify that the default
message file is named correctly, and correct it as necessary.
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Important: Failing to correctly specify the message file’s name when you configure
the ODA causes it to run without messages. For more information on
specifying the message file name, see [“Configure initialization|
[properties” on page 55}

During the configuration process, you specify:

¢ The name of the file into which PeopleSoftODA writes error and trace
information

* The level of tracing, which ranges from 0 to 5.

describes these values.

Table 10. Tracing levels

Trace Level Description

Logs all errors

Traces all entering and exiting messages for method

Traces the ODA’s properties and their values

Traces details of all spawned threads

0
1
2
3 Traces the names of all business objects
4
5

* Indicates the ODA initialization values for all of its properties  Traces a
detailed status of each thread that PeopleSoftODA spawned ¢ Traces the
business object definition dump

For information on where you configure these values, seel”Conﬁgure initializationl
[properties” on page 55|

Using PeopleSoftODA in Business Object Designer Express

This section describes how to use PeopleSoftODA in Business Object Designer
Express to generate business object definitions. For information on launching
Business Object Designer Express, see the Business Object Development Guide.

After you launch an ODA, you must launch Business Object Designer Express to
configure and run it. There are six steps in Business Object Designer Express to
generate business object definitions using an ODA. Business Object Designer
Express provides a wizard that guides you through each of these steps.

After starting the ODA, do the following to start the wizard:
1. Open Business Object Designer Express.
2. From the File menu, select the New Using ODA... submenu.

Business Object Designer Express displays the first window in the wizard,
named Select Agent. [Figure 11 on page 55|illustrates this window.

To select, configure, and run the ODA, follow these steps:
. |“Select the ODA” on page 55|

—_

. |“Configure initialization properties” on page 55

. |“Expand nodes and select component interfaces and collections” on page 57

2
3
4. [“Confirm selection of objects” on page 5§
5

“Generate the definition” on page 59|and, optionally, [“Provide additionall
information” on page 59|
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6. |“Save the definition” on page 60

Select the ODA

illustrates the first dialog box in Business Object Designer Express’s
six-step wizard. From this window, select the ODA to run.

Business Object Wizard - Step 1 of 6 - Select Agent

Press "Find Agents" to locate DDAz
in pour subnet [9.26.237 s You
will be given an estimate of the time
required to complete the operation
and a means to cancel the search.

If you have an ODA that iz running

= B3

Located agents:

FeopleSoft0 DA MWW 2000PRD:E7OSY
WSDLODA [9.26.237.58:57037]

on a machine outside subnet
9.26.237 uxn press "Configure
Digcovery' to include that machine

it the zearch.

Configure Discovery |
Find Agents |

< | =

Agent's name: PeopleSoft0DA

IWIN2EIDDF'F|D

IE?DEI?

Agent's host:

Part:

< Hach | Mext » Cancel

Figure 11. Selecting the ODA

To select the ODA:

1. Click the Find Agents button to display all registered or currently running
ODAs in the Located agents field.

Note: If Business Object Designer Express does not locate your desired ODA,
check the setup of the ODA.

2. Select the desired ODA from the displayed list.

Business Object Designer Express displays your selection in the Agent’s name

field.

Configure initialization properties
The first time Business Object Designer Express communicates with
PeopleSoftODA, it prompts you to enter a set of initialization properties as shown
in You can save these properties in a named profile so that you do not
need to re-enter them each time you use PeopleSoftODA. For information on
specifying an ODA profile, see the Business Object Development Guide.
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Businezs Object Wizard - Step 2 of 6 - Configure Agent

— Profiles
Current profile: I vl
Save | Hew | Eemove |
Property Value Type Description
1 UzerMame String User Matmne to Log into th
2  |Password String Password to Log into th
3 |appServerMac String The PeopleSoftippSery
4 |portMumber String Port Mumker .
5 |DefautBOPrefi String The default prefix for th
E |TraceFileMame |PeopleSoftODAtrace txt String Matme of the trace file.
7 |TracelLevel 3 Integer Trace level for the ager
8 |MeszageFie |PeopleSoftODAbgent txt String Path to the message file
4] | i
< Back I Mext > I Cancel I

Figure 12. Configuring agent initialization properties

Configure the PeopleSoftODA properties described in [Table 11
Table 11. PeopleSoftODA properties

Row
number

1

Property name

UserName
Password
AppServerMachineName

PortNumber

DefaultBOPrefix

TraceFileName

Tracelevel

Property type
String

String
String

String

String

String

Integer

Description

Name of the user with authorization to connect to the
PeopleSoft application using the Application Server
Password of the user with authorization to connect to the
PeopleSoft application

Name or IP address of the machine on which the
PeopleSoft Server is running

The Jolt port used to connect to the Application Server.
The default value is 9000. Note: This port is different from
the Tuxedo port.

Text that is prepended to the name of the business object
to make it unique. The prefix cannot begin with an
underscore (_). You can change this value later, if required,
when Business Object Designer Express prompts you for
business object properties. For more information, see
|“Provide additional information” on page 59|

File into which PeopleSoftODA writes trace information. If
the file does not exist, PeopleSoftODA creates it in the
\ODA\PeopleSoft directory. If the file already exists,
PeopleSoftODA appends to it. PeopleSoftODA names the
file according to the naming convention. For example, if
the agent is named PeopleSoftODA, it generates a trace file
named PeopleSoftODAtrace.txt. Use this property to
specify a different name for this file.

Level of tracing enabled for PeopleSoftODA. For more
information, see ["Working with error and trace message|
files” on page 53
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Table 11. PeopleSoftODA properties (continued)

Row
number Property name Property type  Description
8 MessageFile String Name of the error and message file. PeopleSoftODA

displays the filename according to the naming convention.
For example, if the agent is named PeopleSoftO0DA, the
value of the message file property displays as
PeopleSoftODAAgent.txt.Important: The error and
message file must be located in the \ODA\messages
directory. Use this property to verify or specify an existing
file.

Important: Correct the name of the message file if the default value displayed in
Business Object Designer Express represents a non-existent file. If the
name is not correct when you move forward from this dialog box,
Business Object Designer Express displays an error message in the
window from which the ODA was launched. This message does not
popup in Business Object Designer Express. Failing to specify a valid
message file causes the ODA to run without messages.

Expand nodes and select component interfaces and
collections

Business Object Designer Express uses the properties configured in the previous
step to create a connect string that connects the tool to the specified PeopleSoft
application. After connecting, Business Object Designer Express displays a tree
whose nodes represent all the Component Interfaces defined in the PeopleSoft
application.

Click on a node to display the next-level Collection of the Component Interface.
You can expand the Component Interfaces to display the entire hierarchical
representation. For each Collection, PeopleSoftODA creates a child business object
definition.

illustrates this dialog box with some Component Interfaces expanded.
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Buszinezs Object Wizard - Step 3 of 6 - Select Source [_ [ %]

From the tree below, select the source nodes from which the Designer will generate Business

Objects. Click "Mext" to continue.

Use this object instead

Mame Description ;l
- CORPORATE_CARD Component Interface
-~ COUNTRY Component Interface
-~ CURRENCY Component Interface
- CWEYENT_CI Component Interface
- CWTEST_CI Component Interface
- CwCHILD1_TBL Collection
- CwWCHILD2_TBL Collection

- DELETE_ROLE Component Interface
-~ DELETE_USER_PROFILE Component Interface
= DEPT Component Interface
-~ EMPLOYEE_CORPORATE_CARD Component Interface
-+ EO0_BUILDRULE Component Interface
- EO_EIP_WF_MS5G_BC Component Interface
F-ED_EIP_WF_STG_BC Component Interface
ﬂ EO ERROR UTILITY Component Inlerl‘ac:\eI Llll

< Back Mext > I

Figure 13. Tree of component interfaces with expanded nodes

Select all required Component Interfaces, along with all necessary Collections, and
click Next.

Confirm selection of objects

After you identify all the Component Interfaces and Collections to be associated
with the generated business object definitions, Business Object Designer Express
displays the dialog box with only the selected objects. illustrates this
dialog box.

Business Object Wizard - Step 4 of 6 - Confirm source nodes for busine... [H|E E3

Buginess objects are about to be generated uzing the source nodes summarized below.
Click "Mext" to start generating the objects or click "Back' to change vour selection.

Mame Description
- CWTEST_CI Component Interface
=l CWCHILD1_TBL Collection
- CWCHILD2_TBL Collection
= DEPT Component Interface
- DEPT_TBL Collection

| ¥

< Back I Mest > I

Cancel |

Figure 14. Confirming selection of objects
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This window provides the following options:
e To confirm the selection, click Next.

e If the selection is not correct, click Back to return to the previous window and
make the necessary changes. When the selection is correct, click Next.

Generate the definition

After you confirm the Component Interfaces and Collections, the next dialog box
informs you that Business Object Designer Express is generating the definitions. If
a large number of Component Interfaces has been selected, this generation step can
take time.

illustrates this dialog box.

Please wart as the wizard gensrates
bugiress objectz, which may take some
time.

Some buziness objects may require
additional information. The wizard will
prompt yauw far that information if
required.

Obtaining BO-specific informatan...

Carzel

Figure 15. Generating the definition

Provide additional information
If the PeopleSoftODA needs additional information, Business Object Designer
Express displays the BO Properties window, which prompts you for the

information. [Figure 16 illustrates this dialog box.
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Business Object Wizard - Step 5 of 6 - Generating business objects. ..

BO Properties
Several BOg require additional configuration. Please provide values for the properties below
and press "0K"

Property Value Type Description
1 Prefix PSFT String Prefix that =hould he applied to ea
2 |Verbs - | String “Yerbs that are applicable to all the
W
[v|Retrieve
[wDelete
[v]pciate
[w|RetrieveByConter
l | 2
oK
< Hack | Iaenernate l Cancel

Figure 16. Providing additional Information

In the BO Properties window, enter or change the following information:

* Prefix—The text that is prepended to the name of the business object to make it
unique. If you are satisfied with the value you entered for the DefaultBOPrefix
property in the Configure Agent window (Figure 12 on page 56), you do not
need to change the value here.

e Verbs— Click in the Value field and select one or more verbs from the pop-up
menu. These are the verbs supported by the business object.

Note: If a field in the BO Properties dialog box has multiple values, the field
appears to be empty when the dialog box first displays. Click in the field
to display a drop-down list of its values.

Save the definition

After you provide all required information in the BO Properties dialog box and
click OK, Business Object Designer Express displays the final dialog box in the
wizard. In this dialog box, you can save the definition to the server or to a file, or
you can open the definition for editing in Business Object Designer Express. For
more information, and to make further modifications, see the Business Object
Development Guide.

illustrates this dialog box.
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Businezs Object Wizard - Step b of 6 - Save business objects M= E3

Busness objects were successtully created. You can save their definition to the
gerver now of do it later if pou wish to inzpect them first.

7| Save business ohjects to the senver

[ Save business objects ta & file

[" Open the new BOs in separate windows

< Back I Firizh I Cancel

Figure 17. Saving the business object definition

Contents of the generated definition

The business object definition that PeopleSoftODA generates contains:
* A simple attribute for each property in the specified Component Interface

* An attribute that represents an array of child business objects for each Collection
that was selected in the hierarchical representation of the Component Interface

« The verbs specified in the BO Properties window (Figure 16 on page 60)

* Application-specific information:
— At the business-object level
— For each attribute

This section describes:

* |“Business-object-level properties’|

* |“Attribute properties” on page 62|

Business-object-level properties
PeopleSoftODA generates the following information at the business-object level:
* Name of the business object
* Version—defaults to 1.0.0
* Application-specific information

At the business-object level, application-specific information format consists of four
parameters separated by a colon (:) delimiter. The format is:

cIName=ComponentInterface:EFFDT=[true|false] :setInteractiveMode=[true|false]:
GetHistoryItems=[true|false]:SetEditHistoryItems=[true|false]

Chapter 4. Generating business object definitions using PeopleSoftODA 61



describes these parameters.

Table 12. AppSpecificlnfo at the business-object level

AppSpecificInfo Parameter Description

ComponentInterface Specifies the name of the Component Interface defined in
the PeopleSoft application

setInteractiveMode Determines when the connector sends changes to the
Application Server

GetHistoryItems Determines how much data the connector retrieves

EFFDT Specifies whether the business object (or child business
object) uses an Effective Date

SetEditHistoryltems Enables editing and saving of history data. Applies to

effective-dated fields only.

Important: PeopleSoftODA uses the name of the Component Interface from which
it has generated the definition to specify a value for the
ComponentInterface property. It does not provide values for the other
properties. You must modify the business object definition to provide
values for the remaining properties. For information on these
properties, see [”Application-specific information at the business object]
[level” on page 45| For information on modifying a business object
definition, see the Business Object Development Guide.

Attribute properties
This section describes the properties that PeopleSoftODA generates for each
attribute. For more information about the attributes, see [“Business object attribute|
[properties” on page 43|

Name property
PeopleSoftODA derives the attribute’s name from a property in the corresponding
Component Interface.

Data type property

When setting the type of an attribute, PeopleSoftODA converts the data type of a
property into a corresponding business object data type as shown in|[Table 1

Table 13. Correspondence of data types

PeopleSoft Business object Length

String String Length specified in the data type
Boolean Boolean

Collection Object

Float Float

Number Integer

Note: If a property’s data type is not one of those shown in [Iable 13
PeopleSoftODA skips the property and displays a message stating that the

property cannot be processed.

Cardinality property
PeopleSoftODA sets the cardinality of all simple attributes to 1. It sets the
cardinality of all attributes that represent an array of child business objects to n.
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MaxLength property

PeopleSoftODA provides the default length of 255 characters for strings; for all
other data types, it uses the standard maximum length for the corresponding
business object data type.

IsKey property

If a property is a CreateKey in a Component Interface, PeopleSoftODA sets this
property to true. If a property is a GetKey in a Component Interface,
PeopleSoftODA sets this property to false, and sets the attribute’s AppSpecificInfo
parameter to GetKey=true.

IsForeignKey property
PeopleSoftODA sets this property to false. You can change the setting in Business
Object Designer Express.

IsRequired property
Because PeopleSoftODA generates some keys internally, it always sets this property
to false. You can change the setting in Business Object Designer Express.

AppSpecificinfo property

Attribute application-specific information is a set of five name-value parameters
that are separated from one another by a colon (:) delimiter. A vertical bar (1)
separates the members of a set of options. The format is:

get=getFieldName:set=setFieldName:UID=[true|false] :GetKey=[true|false]:KeepRelationship=[true|false]

PeopleSoftODA generates only those properties that are relevant to an attribute, as
described in [Table 14/ If it generates more than one parameter, it separates
parameters with a colon.

Table 14. Attribute AppSpecificinfo generated by PeopleSoftODA

AppSpecificInfo parameter Description

GetKey=true PeopleSoftODA generates this parameter only for
attributes that correspond to a Component Interface
property defined as a GetKey. The connector uses the
value of such an attribute to retrieve Component
Interface instances.

get=getPropertyName For PropertyName, PeopleSoftODA substitutes the
name of the Component Interface property associated
with the attribute. It generates this parameter for
every simple attribute that corresponds to a
Component Interface property. The connector uses this
method to retrieve values for the attribute.

get=getCollectionName For CollectionName, PeopleSoftODA substitutes the
name of the Component Interface Collection
associated with the attribute. It generates this
parameter for every attribute that represents an array
of child business objects corresponding to a
Component Interface Collection. The connector uses
this method to retrieve the Collection.

set=setPropertyName For PropertyName, PeopleSoftODA substitutes the
name of the Component Interface property associated
with the attribute. It generates this parameter for
every simple attribute that corresponds to a
Component Interface property. The connector uses the
method to update values for the attribute.
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Note: You can set additional AppSpecificInfo parameters in Business Object
Designer Express. For information about these parameters, see
[“ Application-specific information at the attribute level” on page 47} For
more information on modifying definitions, see the Business Object
Development Guide. For an example of using the parameters described in
[Table 14} see [“Sample business object definition file” on page 64}

Verbs

Note: PeopleSoftODA generates the verbs specified in the BO Properties window
(as illustrated in [Figure 16 on page 60)).

Sample business object definition file

There are three sample business object definition files included with the product:
* BO_Psft_ DEPT

* BO_PsftEmployee

* SavePostChange

BO_Psft_DEPT business object
The following example is the BO_Psft DEPT business object.

[BusinessObjectDefinition] Name = DeptTbl Version = 1.0.0 AppSpecificInfo =
CiName=DEPT [Attribute] Name = Company Type = String
MaxLength = 255 IsKey = true IsForeignKey = false IsRequired =
false AppSpecificInfo = get=getCompany:set=setCompany
IsRequiredServerBound = false [End] [Attribute] Name =
BudgetLvl Type = String MaxLength = 1 IsKey = false
IsForeignKey = false IsRequired = false AppSpecificInfo =
get=getBudgetlLvl:set=setBudgetLv] IsRequiredServerBound = false
[End] [Attribute] Name = Descr Type = String MaxLength = 1
IsKey = false IsForeignKey = false IsRequired = false
AppSpecificInfo = get=getDescr:set=setDescr IsRequiredServerBound =
false [End] [Attribute] Name = DescrShort Type = String
MaxLength = 1 IsKey = false IsForeignKey = false IsRequired =
false AppSpecificInfo = get=getDescrshort:set=setDescrshort
IsRequiredServerBound = false [End] [Attribute] Name =
ObjectEventId Type = String MaxLength = 255 IsKey = false
IsForeignKey = false IsRequired = false IsRequiredServerBound =
false [End] [Verb] Name = Create [End] [Verb] Name
= Delete [End] [Verb] Name = Retrieve [End] [Verb]
Name = Update [End] [End] [BusinessObjectDefinition] Name = Psft_ dept
Version = 1.0.0 AppSpecificInfo = CiName=DEPT [Attribute] Name =
Deptid Type = String MaxLength = 255 IsKey = true
IsForeignKey = false IsRequired = true AppSpecificInfo =
get=getDeptid:set=setDeptid:GetKey=true IsRequiredServerBound = false
[End] [Attribute] Name = Setid Type = String MaxLength
=1 IsKey = true IsForeignKey = false IsRequired = true
AppSpecificInfo = get=getSetid:set=setSetid:GetKey=true
IsRequiredServerBound = false [End] [Attribute] Name = DptTbl
Type = DeptTbl ContainedObjectVersion = 1.0.0 Relationship =
Containment Cardinality = n MaxLength = 1 Iskey = false
IsForeignKey = false IsRequired = true AppSpecificInfo =
get=getDeptTb1:KEEPRELATIONSHIP=true IsRequiredServerBound = false
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[End] [Attribute] Name = ObjectEventId Type = String
MaxLength = 255 Iskey = false IsForeignKey = false IsRequired =

false IsRequiredServerBound = false [End] [Verb] Name =
Create [End] [Verb] Name = Delete [End] [Verb] Name
= Retrieve [End] [Verb] Name = Update [End] [End]

BO_PsftEmployee business object

The following example is the BO_PsftEmployee business object.

[BusinessObjectDefinition] Name = PSFTEmployee Version = 1.0.0
AppSpecificInfo = cIName=Emp [Attribute] Name = EMPID Type =
String Cardinality =1 MaxLength = 255 IsKey = true
IsForeignKey = false IsRequired = true AppSpecificInfo =
get=getEmplid:set=setEmplid:keepRelationship=false:uid=true:

findKey=true:getKey=true:createkKey=true IsRequiredServerBound = false
[End] [Attribute] Name = EMPL_RCD Type = String
Cardinality =1 MaxLength = 1 IsKey = true IsForeignKey = false

IsRequired = true AppSpecificInfo =
get=getEmpIRcd:set=setEmp1Rcd:keepRelationship=false:uid=true:

findKey=true:getKey=true:createKey=true IsRequiredServerBound = false
[End] [Attribute] Name = NAME Type = String Cardinality
=1 MaxLength = 1 IsKey = true IsForeignKey = false

IsRequired = true AppSpecificInfo =
get=getName:set=setName:keepRelationship=false:uid=false:

findKey=true:getKey=false:createKey=false IsRequiredServerBound = false
[End] [Attribute] Name = LAST_NAME_SRCH Type = String
Cardinality = 1 MaxLength =1 IsKey = true IsForeignKey = false

IsRequired = true AppSpecificInfo =
get=getLastNameSrch:set=setLastNameSrch:keepRelationship=false:uid=false:

findKey=true:getKey=false:createKey=false IsRequiredServerBound =
false [End] [Attribute] Name = NAME_AC Type = String
Cardinality =1 MaxLength = 1 IsKey = true IsForeignKey = false

IsRequired = true AppSpecificInfo =
get=getNameAc:set=setNameAc:keepRelationship=false:uid=false:
findKey=true:getKey=false:createKey=false IsRequiredServerBound

[End] [Attribute] Name = PER_STATUS Type = String
Cardinality =1 MaxLength = 1 IsKey = true IsForeignKey

IsRequired = true AppSpecificInfo =
get=getPerStatus:set=setPerStatus:keepRelationship=false:uid=false:
findKey=true:getKey=false:createKey=false IsRequiredServerBound

[End] [Attribute] Name = EMPLID 0 Type = String
Cardinality =1 MaxLength = 1 IsKey = false IsForeignKey
false IsRequired = false AppSpecificInfo =
get=getEmplidO:set=setEmp1id0:keepRelationship=false:uid=false:
findKey=false:getKey=false:createKey=false IsRequiredServerBound
false [End] [Attribute] Name = ORIG_HIRE DT Type = String

Cardinality =1 MaxLength = 1 IsKey = false IsForeignKey =
false IsRequired = false AppSpecificInfo =
get=getOrigHireDt:set=setOrigHireDt:keepRelationship=false:uid=false:
findKey=false:getKey=false:createKey=false IsRequiredServerBound
false [End] [Attribute] Name = SEX Type = String
Cardinality =1 MaxLength = 1 IsKey = false IsForeignKey
false IsRequired = true AppSpecificInfo =
get=getSex:set=setSex:keepRelationship=false:uid=false:findKey=false:
getKey=false:createKey=false IsRequiredServerBound = false [End]

false

false

false
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[Attribute] Name = BIRTHDATE Type = String Cardinality =1

MaxLength = 1 IsKey = false IsForeignKey = false IsRequired
= false AppSpecificInfo =
get=getBirthdate:set=setBirthdate:keepRelationship=false:
uid=false:findKey=false:getKey=false:createkKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
FT_STUDENT Type = String Cardinality =1 MaxLength = 1
IsKey = false IsForeignKey = false IsRequired = true

AppSpecificInfo = get=getFtStudent:set=setFtStudent:keepRelationship=false:
uid=false:findKey=false:getKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
BENEFIT_RCD_NBR Type = String Cardinality =1 MaxLength = 1
IsKey = false IsForeignKey = false IsRequired = false

AppSpecificInfo = get=getBenefitRcdNbr:set=setBenefitRcdNbr:
keepRelationship=false:uid=false:findKey=false:getKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
HOME_HOST_CLASS Type = String Cardinality =1 MaxLength = 1
IsKey = false IsForeignKey = false IsRequired = true

AppSpecificInfo = get=getHomeHostClass:set=setHomeHostClass:
keepRelationship=false:uid=false:findKey=false:getKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
HIRE_DT Type = String Cardinality =1 MaxLength = 1 IsKey =
false IsForeignKey = false IsRequired = false AppSpecificIlnfo =

get=getHireDt:set=setHireDt:keepRelationship=false:
uid=false:findKey=false:getKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
CMPNY_SENIORITY DT Type = String Cardinality =1 MaxLength = 1
IsKey = false IsForeignKey = false IsRequired = false

AppSpecificInfo = get=getCmpnySeniorityDt:
set=setCmpnySeniorityDt:keepRelationship=false:uid=false:

findKey=false:getKey=false:createKey=false IsRequiredServerBound =
false [End] [Attribute] Name = SERVICE DT Type = String
Cardinality =1 MaxLength = 1 IsKey = false IsForeignKey =

false IsRequired = false AppSpecificInfo =
get=getServiceDt:set=setServiceDt:
keepRelationship=false:uid=false:findKey=false:getKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
PROF_EXPERIENCE DT Type = String Cardinality = 1 MaxLength = 1
IsKey = false IsForeignKey = false IsRequired = false

AppSpecificInfo = get=getProfExperienceDt:
set=setProfExperienceDt:keepRelationship=false:uid=false:

findKey=false:getKey=false:createKey=false IsRequiredServerBound =
false [End] [Attribute] Name = LAST_VERIFICATN DT Type =
String Cardinality =1 MaxLength = 1 IsKey = false

IsForeignKey = false IsRequired = false AppSpecificInfo =
get=getlLastVerificatnDt:set=setlLastVerificatnDt:
keepRelationship=false:uid=false:findKey=false:getKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
EXPECTED_RETURN_DT Type = String Cardinality =1 MaxLength = 1
IsKey = false IsForeignKey = false IsRequired = false

AppSpecificInfo = get=getExpectedReturnDt:set=
setExpectedReturnDt:keepRelationship=false:
uid=false:findKey=false:getKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
LAST _DATE_WORKED Type = String Cardinality =1 MaxLength = 1
IsKey = false IsForeignKey = false IsRequired = false
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AppSpecificInfo = get=getlLastDateWorked:
set=setlLastDateWorked:keepRelationship=false:uid=false:
findKey=false:getKey=false:createKey=false IsRequiredServerBound =
false [End] [Attribute] Name = LAST_INCREASE DT Type
String Cardinality =1 MaxLength = 1 Iskey = false
IsForeignKey = false IsRequired = false AppSpecificInfo =
get=getlLastIncreaseDt: set=setlastIncreaseDt:keepRelationship=false:
uid=false:findKey=false:getKey=false:createKey=false
IsRequiredServerBound = false [End] [Attribute] Name =
OWN_5PERCENT_CO Type = String Cardinality =1 MaxLength = 1
IsKey = false IsForeignKey = false IsRequired = true
AppSpecificInfo = get=getOwn5percentCo:
set=setOwn5percentCo: keepRelationship=false:
uid=false:findKey=false:getKey=false:createkKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
BUSINESS TITLE Type = String Cardinality =1 MaxLength = 1
IsKey = true IsForeignKey = false IsRequired = true

AppSpecificInfo = get=getBusinessTitle:
set=setBusinessTitle:keepRelationship=false:
uid=false:findKey=false:getKey=true:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =

REPORTS_TO Type = String Cardinality =1 MaxLength = 1

IsKey = false IsForeignKey = false IsRequired = false

AppSpecificInfo = get=getReportsTo:set=setReportsTo:

keepRelationship=false:uid=false:findKey=false:getKey=false:createKey=false
IsRequiredServerBound = false [End] [Attribute] Name =

SUPERVISOR ID Type = String Cardinality = 1 MaxLength = 1

IsKey = false IsForeignKey = false IsRequired = false

AppSpecificInfo = get=getSupervisorld:set=setSupervisorld:
keepRelationship=false:uid=false:findKey=false:getKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
PROBATION DT Type = String Cardinality =1 MaxLength =1
IsKey = false IsForeignKey = false IsRequired = false

AppSpecificInfo = get=getProbationDt:set=setProbationDt:
keepRelationship=false:uid=false:findKey=false:getkKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
SECURITY_CLEARANCE Type = String Cardinality = 1 MaxLength = 1
IsKey = false IsForeignKey = false IsRequired = false

AppSpecificInfo = get=getSecurityClearance:
set=setSecurityClearance:keepRelationship=false:
uid=false:findKey=false:getKey=false:createkKey=false

IsRequiredServerBound = false [End] [Attribute] Name = PHONE
Type = String Cardinality =1 MaxLength =1 IsKey = false
IsForeignKey = false IsRequired = false AppSpecificInfo =

get=getPhone:set=setPhone: keepRelationship=false:uid=false:

findKey=false:getKey=false:createKey=false IsRequiredServerBound =
false [End] [Attribute] Name = TIME RPT_LOCK Type = String
Cardinality =1 MaxLength = 1 IsKey = false IsForeignKey =

false IsRequired = false AppSpecificInfo =
get=getTimeRptLock:set=setTimeRptLock:
keepRelationship=false:uid=false:findKey=false:getKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
JOB_REPORTING Type = String Cardinality =1 MaxLength = 1
IsKey = false IsForeignKey = false IsRequired = true

AppSpecificInfo = get=getJobReporting:set=setJobReporting:
keepRelationship=false:uid=false:findKey=false:getKey=false:createKey=false
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IsRequiredServerBound = false [End] [Attribute] Name =
DED_TAKEN Type = String Cardinality =1 MaxLength = 1 IsKey
= false IsForeignKey = false IsRequired = true AppSpecificInfo
get=getDedTaken:set=setDedTaken:
keepRelationship=false:uid=false:findKey=false:getKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
DED_SUBSET_ID Type = String Cardinality =1 MaxLength = 1
IsKey = false IsForeignKey = false IsRequired = false

AppSpecificInfo = get=getDedSubsetId:set=setDedSubsetlId:
keepRelationship=false:uid=false:findKey=false:getKey=false:createkKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
CAN_ABORIGINAL Type = String Cardinality =1 MaxLength = 1
IsKey = false IsForeignKey = false IsRequired = false

AppSpecificInfo = get=getCanAboriginal:set=setCanAboriginal:
keepRelationship=false:uid=false:findKey=false:getKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
CAN_VISBL_MINORITY Type = String Cardinality =1 MaxLength =1
IsKey = false IsForeignKey = false IsRequired = true

AppSpecificInfo = get=getCanVisbIMinority:set=setCanVisbIMinority:
keepRelationship=false:uid=false:findKey=false:getKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
CURRENT_SEQ Type = String Cardinality =1 MaxLength = 1
IsKey = false IsForeignKey = false IsRequired = false

AppSpecificInfo = get=getCurrentSeq:set=setCurrentSeq:
keepRelationship=false:uid=false:findKey=false:getKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =
PERS DATA EFFDT Type = PERS_DATA EFFDT ContainedObjectVersion =
1.0.0 Relationship = Containment Cardinality = n MaxLength = 1

IsKey = false IsForeignKey = false IsRequired = false

AppSpecificInfo = get=getPersDataEffdt:keepRelationship=false:
uid=false:findKey=false:getKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =

EMAIL_ADDRESSES Type = EMAIL_ADDRESSES ContainedObjectVersion =

1.0.0 Relationship = Containment Cardinality = n MaxLength = 1
IsKey = false IsForeignKey = false IsRequired = false

AppSpecificInfo = get=getEmailAddresses:keepRelationship=false:
uid=false:findKey=false:getKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name =

PERSONAL_PHONE Type = PERSONAL_PHONE ContainedObjectVersion = 1.0.0
Relationship = Containment Cardinality = n MaxLength = 1

IsKey = false IsForeignKey = false IsRequired = false

AppSpecificInfo = get=getPersonalPhone:keepRelationship=false:

uid=false:findKey=false:getKey=false:createKey=false

IsRequiredServerBound = false [End] [Attribute] Name = PERS_NID
Type = PERS_NID ContainedObjectVersion = 1.0.0 Relationship =

Containment Cardinality = n MaxLength = 1 IsKey = false

IsForeignKey = false IsRequired = false IsRequiredServerBound =

false [End] [Attribute] Name = JOB Type = JOB

ContainedObjectVersion = 1.0.0 Relationship = Containment

Cardinality = n MaxLength = 1 IsKey = false IsForeignKey =

false IsRequired = false IsRequiredServerBound = false [End]
[Attribute] Name = ObjectEventld Type = String MaxLength =

255 IsKey = false IsForeignKey = false IsRequired = false

IsRequiredServerBound = false [End] [Verb] Name = Create

[End] [Verb] Name = Delete [End] [Verb] Name = Retrieve
[End] [Verb] Name = Update [End] [End]
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SavePostChange business object

The following example is the SavePostChange business object.

/* Place this code in Component's SavePostChg() and define the four
parameters used in the function call */ Declare Function cw_publish_event
PeopleCode FUNCLIB_CW.CW_EVENT_NOT FieldFormula; Component string &BONAMEL;
Component string &KEYLIST1; Component number &CWPRIORITY1; Component string
&CONNID; &BONAME1l = "Psft Dept"; &KEYLIST1 =

"DEPT TBL.SETID:DEPT TBL.DEPTID"; &CWPRIORITY1l = 2; &CONNID = "PeopleSoft
Connector"; /* Check if Component Changed before calling function %/ If
ComponentChanged() And %UserId <> "CW" Then /* Publish this event to
the CrossWorlds CW_EVENT_TBL for polling */ cw_publish_event (&BONAMEL,
&KEYLIST1, &CWPRIORITY1, &CONNID); End-If;

Modifying information in the business object definition

It may be necessary to modify information in the business object definition that
PeopleSoftODA creates. For example, you must manually remove unwanted
attributes, change the default values for the getHistoryItems and
setInteractiveMode parameters of the application-specific information at the
business-object level, and add required parameters for attribute application-specific
information. For more information, see [Chapter 3, “Understanding business obijectd
ffor the connector,” on page 27.|

To examine or modify the business object definition, you can use Business Object
Designer Express or a text editor. To reload a revised definition into the repository,
you can use Business Object Designer Express.
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Chapter 5. Troubleshooting and error handling

The chapter describes problems that you may encounter when starting up or
running the Adapter for PeopleSoft.

This chapter contains the following sections:

“Startup problems”|

“Processing Problems”]

“Mapping” on page 72|

[“Error Handling and Logging” on page 72'
[“Loss of Connection to the Application” on page 73|

Startup problems

If you encounter difficulties when trying to start the connector, do the following:

Use the psadmin utility to check that the PeopleSoft Application Server is
running.

Use the Test Component Interface utility in Application Designer to verify that
the Component Interface is working online.

Rebuild and recompile the APIs in PeopleSoft. For more information, see
[“Generating APIs” on page 33|

Verify that PeopleSoft security has been set correctly, and that the Component
Interface is listed on the Permission List, and that time-out has been configured
for the connector’s user account. For more information, see
[time-out for the user account” on page 13}

Verify that Row-Level Security has been set for the connector’s user account.

Trace the API by selecting relevant options on the Trace tab in the PeopleSoft
Configuration Manager.

Processing Problems

If an error occurs when the connector is processing, create a simple Java program
and test the following using IDE:

1.
2.
3.

The connection to the application
The Get (), Create(), and Find() methods

The retrieval of Property values from each level of the corresponding
Component Interface

This test can isolate problems arising between the PeopleSoft API and the
connector. In other words, if you have no problems in the test program, then there
probably is a problem with the connector code.

PeopleSoft generates a template for a test Java program. To generate the template:

1.
2.

© Copyright IBM Corp. 2004

Open the Component Interface in question.

Right click anywhere in the window and select Generate Java Template from
the popup menu.
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Mapping

If the business objects are not being mapped or mapping is not being invoked,
check to make sure the maps have been installed in the correct directory.

Error Handling and Logging

The connector logs an error message whenever it encounters a condition that
causes its current processing of a business object and verb to fail. When such an
error occurs, the connector also prints a textual representation of the failed
business object as it received it. It writes the text to the connector log file or the
standard output stream, depending on its configuration. You can use the text as an
aid in determining the source of the error.

Error Types

describes the types of tracing messages that the connector outputs at each
trace level. These messages are in addition to any tracing messages output by the
WebSphere business integration system’s architecture, such as the Java connector
execution wrapper.

Table 15. PeopleSoft Tracing Messages

Tracing Level Tracing Messages

Level 0 Message that identifies the connector version. No other tracing is
done at this level. This is the default value.

Level 1 .

Status messages

* Messages that provide identifying (key) information for each
business object processed

* Messages delivered each time the pollForEvents method is
executed

Level 2 * Business object handler messages that contain information such as

the arrays and child business objects that the connector encounters
or retrieves during the processing of a business object

* Messages logged each time a business object is posted to the
InterChange Server Express, either from gotApplEvent() or
consumeSync()

* Messages that indicate that a business object has been received as
a request

Level 3 * Foreign key processing messages that contain such information as

when the connector has found or has set a foreign key in a
business object

* Messages that provide information about business object
processing. For example, these messages are delivered when the
connector finds a match between business objects, or finds a
business object in an array of child business objects

Level 4 * Application-specific information messages, for example, messages

showing the values returned by the functions that parse the
business object’s application-specific information fields

* Messages that identify when the connector enters or exits a
function, which helps trace the process flow of the connector

* All thread-specific messages. If the connector spawns multiple
threads, a message appears for the creation of each new thread.
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Table 15. PeopleSoft Tracing Messages (continued)

Tracing Level Tracing Messages

Level 5 * Messages that indicate connector initialization, for example,

messages showing the value of each configuration property
retrieved from InterChange Server Express.

* Messages that include statements executed in the application. At
this trace level, the connector log file contains all statements
executed in the destination application and the value of any
variables that are substituted.

* Messages that comprises a representation of a business object
before the connector begins processing it (displaying its state as
the connector receives it) and after the connector has completed its
processing (displaying its state as the connector returns it to
InterChange Server Express)

* Messages that comprise a business object dump

¢ Messages that indicate the status of each thread the connector
spawns while it is running

Error Messages

All the error messages that the connector generates are stored in a message file
named PeopleSoftConnector.txt. Each error has an error number followed by the
error message. For example:

1210

PeopleSoft Connector unable to initialize.
1211

PeopleSoft Connector failed to locate.

Loss of Connection to the Application

If the connector’s application-specific component fails to establish connection, it
sends FAIL to InterChange Server Express and terminates.
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Appendix A. Standard configuration properties for connectors

This appendix describes the standard configuration properties for the connector
component of the adapters in WebSphere Business Integration Server Express,
running on WebSphere InterChange Server Express.

Not every connector makes use of all these standard properties. When you select
an integration broker from Connector Configurator Express, you will see a list of
the standard properties that you need to configure for your adapter.

For information about properties specific to the connector, see the relevant adapter
user guide.

Configuring standard connector properties

Adapter connectors have two types of configuration properties:
¢ Standard configuration properties
 Connector-specific configuration properties

This section describes the standard configuration properties. For information on
configuration properties specific to a connector, see its adapter user guide.

Using Connector Configurator Express

You configure connector properties from Connector Configurator Express, which
you access from System Manager. For more information on using Connector
Configurator Express, refer to the Connector Configurator Express appendix.

Setting and updating property values
The default length of a property field is 255 characters.

The connector uses the following order to determine a property’s value (where the
highest number overrides other values):

1. Default

2. Repository

3. Local configuration file
4. Command line

A connector obtains its configuration values at startup. If you change the value of
one or more connector properties during a run-time session, the property’s Update
Method determines how the change takes effect. There are four different update
methods for standard connector properties:
* Dynamic
The change takes effect immediately after it is saved in System Manager.
* Component restart
The change takes effect only after the connector is stopped and then restarted in
System Manager. You do not need to stop and restart the application-specific
component or the integration broker.
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* Server restart
The change takes effect only after you stop and restart the application-specific
component and the integration broker.

* Agent restart
The change takes effect only after you stop and restart the application-specific
component.

To determine how a specific property is updated, refer to the Update Method

column in the Connector Configurator Express window, or see the Update Method

column in the Property Summary table below.

Summary of standard properties

provides a quick reference to the standard connector configuration
properties. Not all the connectors make use of all these properties, and property
settings may differ from integration broker to integration broker, as standard
property dependencies are based on RepositoryDirectory.

You must set the values of some of these properties before running the connector.
See the following section for an explanation of each property.

Table 16. Summary of standard configuration properties

Update
Property name Possible values Default value method Notes
IAdminIng gueugl Valid JMS queue name CONNECTORNAME /ADMININQUEUE Component | Delivery
restart Transport is
JMS
AdminOutQueue) Valid JMS queue name CONNECTORNAME/ADMINOUTQUEUE [ Component | Delivery
restart Transport is
MS
1-4 1 Component | Delivery
restart Transport is
IDL
0-5 0 Dynamic
Application name Value specified for the Component
connector application name restart
BrokerType 1Cs ICS
|CharacterEncoding] ascii7, ascii8, SJIS, ascii7 Component
Cp949, GBK, Big5h, restart
Cp297, Cp273, Cp280,
Cp284, Cp037, Cp437
Note: This is a subset
of supported
values.
|ConcurrentEventTriggeredFlowsd 1 to 32,767 1 Component | Repository
restart directory
is
<REMOTE>
|ContainerManagedEvents| No value or JMS No value Component | Delivery
restart Transport is
MS
|ControllerStoreAndForwardModed | true or false truetrue Dynamic Repository
directory
is
<REMOTE>
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Table 16. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
|ControllerTraceLevel| 0-5 0 Dynamic Repository
directory
is
<REMOTE>
CONNECTORNAME/DELIVERYQUEUE | Component |JMS transport
| restart only
|DelivervTranspora IDL or JMS DL Component
restart
|DuplicateEventElimination true or false false Component | JMS transport
restart only: Container
Managed Events
must be
<NONE>
|[EnableOidForFlowMonitoring] true or false false Component
restart
|Fault£ 2ueug| CONNECTORNAME / FAULTQUEUE Component | JMS
restart transport
only
hms.FactoryClassNamd CxCommon.Messaging.jms | CxCommon.Messaging. Component | JMS transport
. IBMMQSeriesFactory jms.IBMMQSeriesFactory restart only
or any Java class name
hms.MessageBrokerNamd crossworlds.queue. crossworlds.queue.manager Component | JMS transport
manager restart only
|jmslNumConcurrentRequestS| Positive integer 10 Component | JMS transport
restart only
Any valid password Component | JMS transport
restart only
Any valid name Component | JMS transport
restart only
[]vm MaxHeapSize| Heap size in megabytes 128m Component | Repository
restart directory
is
<REMOTE>
lvmMaxNativeStackSize| Size of stack in kilobytes | 128k Component | Repository
restart directory
is
<REMOTE>
lvmMinHeapSize| Heap size in megabytes Im Component | Repository
restart directory
is
<REMOTE>
ILocald] en_US, ja_JP, ko KR, en_US Component
zh_CN, zh_TW, fr_FR, restart
de_DE,
it_IT, es_ES, pt_BR
Note: This is a
subset of the
supported
locales.
|Log AtInterchangeEnd| true or false false Component
restart
[IMaxEventCapacity| 1-2147483647 2147483647 Dynamic Repository
Directory is
<REMOTE>
||MessageFileNamg| Path or filename InterchangeSystem.txt Component
restart
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Table 16. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
Any valid queue name | CONNECTORNAME/MONITORQUEUE | Component |JMS transport
restart only:
DuplicateEvent
Elimination
must be true
[OADAutoRestartAgent| true or false false Dynamic Repository
Directory is
<REMOTE>
|OADMaxNumRetry| A positive number 1000 Dynamic Repository
Directory is
<REMOTE>
|OADRetryTimelntervall A positive number in 10 Dynamic Repository
minutes Directory is
<REMOTE>
IPollEndTimgI HH:MM HH:MM Component
(HH is 0-23, MM is 0-59) restart
[PollFrequency] A positive integer in 10000 Dynamic
milliseconds
no (to disable polling)
key (to poll only when
the letter p is entered in
the connector’s
Command Prompt
window)
PollQuanti 1-500 1 Agent JMS transport
restart only:
Container
Managed
Events is
specified
PollStartTime HH:MM(HH is 0-23, MM is | HH:MM Component
0-59) restart
[RepositoryDirectory]| Location of metadata Agent Set to
repository restart <REMOTE>
Valid JMS queue name CONNECTORNAME /REQUESTQUEUE Component | Delivery
restart Transport is
JMS
Valid JMS queue name CONNECTORNAME /RESPONSEQUEUE Component | Delivery
restart Transport is
JMS:
[RestartRetryCount| 0-99 3 Dynamic
|RestartRetryIntervall A sensible positive 1 Dynamic
value in minutes:
1 - 2147483547
ISourceQueuel Valid JMS queue name | CONNECTORNAME/SOURCEQUEUE Agent Only if
restart Delivery
Transport is
JMS and
Container
Managed
Events is
specified
|SynchronousRequestQueue| Valid JMS queue name | CONNECTORNAME/ Component | Delivery
SYNCHRONOUSREQUESTQUEUE restart Transport is

TMS
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Table 16. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
|SynchronousRequestTimeout| 0 - any number (millisecs) | 0 Component | Delivery
restart Transport is
JMS
|SynchronousResponseQueud Valid JMS queue name CONNECTORNAME/ Component | Delivery
SYNCHRONOUSRESPONSEQUEUE restart Transport is
JMS
CwBO CwBO Agent
restart

Standard configuration properties

This section lists and defines each of the standard connector configuration
properties.

AdmininQueue

The queue that is used by the integration broker to send administrative messages
to the connector.

The default value is CONNECTORNAME /ADMININQUEUE.

AdminOutQueue

The queue that is used by the connector to send administrative messages to the
integration broker.

The default value is CONNECTORNAME /ADMINOUTQUEUE.

AgentConnections

The AgentConnections property controls the number of ORB connections opened
by orb.init[].

By default, the value of this property is set to 1. There is no need to change this
default.

AgentTracelLevel

Level of trace messages for the application-specific component. The default is 0.
The connector delivers all trace messages applicable at the tracing level set or
lower.

ApplicationName

Name that uniquely identifies the connector’s application. This name is used by
the system administrator to monitor the WebSphere business integration system
environment. This property must have a value before you can run the connector.

BrokerType

Identifies the integration broker that you are using, which is ICS.

CharacterEncoding

Specifies the character code set used to map from a character (such as a letter of
the alphabet, a numeric representation, or a punctuation mark) to a numeric value.
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Note: Java-based connectors do not use this property. A C++ connector currently
uses the value ascii7 for this property.

By default, a subset of supported character encodings only is displayed in the drop
list. To add other supported values to the drop list, you must manually modify the
\Data\Std\stdConnProps.xml file in the product directory. For more information,
see the appendix on using Connector Configurator Express in this guide.

ConcurrentEventTriggeredFlows

Determines how many business objects can be concurrently processed by the
connector for event delivery. Set the value of this attribute to the number of
business objects you want concurrently mapped and delivered. For example, set
the value of this property to 5 to cause five business objects to be concurrently
processed. The default value is 1.

Setting this property to a value greater than 1 allows a connector for a source
application to map multiple event business objects at the same time and deliver
them to multiple collaboration instances simultaneously. This speeds delivery of
business objects to the integration broker, particularly if the business objects use
complex maps. Increasing the arrival rate of business objects to collaborations can
improve overall performance in the system.

To implement concurrent processing for an entire flow (from a source application
to a destination application), you must:

* Configure the collaboration to use multiple threads by setting its Maximum number
of concurrent events property high enough to use multiple threads.

* Ensure that the destination application’s application-specific component can
process requests concurrently. That is, it must be multi-threaded, or be able to
use connector agent parallelism and be configured for multiple processes. Set the
Parallel Process Degree configuration property to a value greater than 1.

The ConcurrentEventTriggeredFlows property has no effect on connector polling,
which is single-threaded and performed serially.

ContainerManagedEvents

This property allows a JMS-enabled connector with a JMS event store to provide
guaranteed event delivery, in which an event is removed from the source queue
and placed on the destination queue as a single JMS transaction.

This property only appears if the DeliveryTransport property is set to the value
JMS.

The default value is No value.

When ContainerManagedEvents is set to JMS, you must configure the following
properties to enable guaranteed event delivery:

* PollQuantity = 1 to 500
* SourceQueue = CONNECTORNAME/SOURCEQUEUE

You must also configure a data handler with the MimeType, DHClass, and
DataHandlerConfigMOName (optional) properties. To set those values, use the
Data Handler tab in Connector Configurator Express. The fields for the values
under the Data Handler tab will be displayed only if you have set
ContainerManagedEvents to JMS.
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Note: When ContainerManagedEvents is set to JMS, the connector does not call its
pol1ForEvents() method, thereby disabling that method’s functionality.

ControllerStoreAndForwardMode

Sets the behavior of the connector controller after it detects that the destination
application-specific component is unavailable.

If this property is set to true and the destination application-specific component is
unavailable when an event reaches ICS, the connector controller blocks the request
to the application-specific component. When the application-specific component
becomes operational, the controller forwards the request to it.

However, if the destination application’s application-specific component becomes
unavailable after the connector controller forwards a service call request to it, the
connector controller fails the request.

If this property is set to false, the connector controller begins failing all service
call requests as soon as it detects that the destination application-specific
component is unavailable.

The default is true.

ControllerTraceLevel
Level of trace messages for the connector controller. The default is 0.

DeliveryQueue
Applicable only if DeliveryTransport is JMS.

The queue that is used by the connector to send business objects to the WebSphere
InterChange Server Express.

The default value is CONNECTORNAME/DELIVERYQUEUE.

DeliveryTransport

Specifies the transport mechanism for the delivery of events. Possible values are
IDL for CORBA IIOP or JMS for Java Messaging Service. The default is IDL.

The connector sends service call requests and administrative messages over
CORBA IIOP if the value configured for the DeliveryTransport property is IDL.

JMS

Enables communication between the connector and client connector framework
using Java Messaging Service (JMS).

If you select JMS as the delivery transport, additional JMS properties such as
Jjms .MessageBrokerName, jms.FactoryClassName, jms.Password, and jms.UserName,
appear in Connector Configurator Express. The first two of these properties are
required for this transport.

Important: There may be a memory limitation if you use the JMS transport

mechanism for a connector running on WebSphere InterChange Server
Express.
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In this environment, you may experience difficulty starting both the connector
controller (on the server side) and the connector (on the client side) due to memory
use within the WebSphere MQ client.

DuplicateEventElimination

When you set this property to true, a JMS-enabled connector can ensure that
duplicate events are not delivered to the delivery queue. To use this feature, the
connector must have a unique event identifier set as the business object’s
ObjectEventld attribute in the application-specific code. This is done during
connector development.

This property can also be set to false.

Note: When DuplicateEventElimination is set to true, you must also configure
the MonitorQueue property to enable guaranteed event delivery.

EnableOidForFlowMonitoring

When you set this property to true, the adapter framework will mark the
incoming ObjectEventld as a foreign key for the purpose of flow monitoring.

The default is false.

FaultQueue

If the connector experiences an error while processing a message then the
connector moves the message to the queue specified in this property, along with a
status indicator and a description of the problem.

The default value is CONNECTORNAME/FAULTQUEUE.

JvmMaxHeapSize
The maximum heap size for the agent (in megabytes).

The default value is 128m.

JvmMaxNativeStackSize

The maximum native stack size for the agent (in kilobytes).

The default value is 128k.

JvmMinHeapSize

The minimum heap size for the agent (in megabytes).

The default value is 1m.

jms.FactoryClassName

Specifies the class name to instantiate for a JMS provider. You must set this
connector property when you choose JMS as your delivery transport mechanism
(DeliveryTransport).

The default is CxCommon.Messaging.jms.IBMMQSeriesFactory.
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jms.MessageBrokerName

Specifies the broker name to use for the JMS provider. You must set this connector
property when you choose JMS as your delivery transport mechanism (see
DeliveryTransport).

The default is crossworlds.queue.manager.

jms.NumConcurrentRequests

Specifies the maximum number of concurrent service call requests that can be sent
to a connector at the same time. Once that maximum is reached, new service calls
block and wait for another request to complete before proceeding.

The default value is 10.

jms.Password
Specifies the password for the JMS provider. A value for this property is optional.

There is no default.

jms.UserName
Specifies the user name for the JMS provider. A value for this property is optional.

There is no default.

Locale

Specifies the language code, country or territory, and, optionally, the associated
character code set. The value of this property determines such cultural conventions
as collation and sort order of data, date and time formats, and the symbols used in
monetary specifications.

A locale name has the following format:
Ul _TT.codeset

where:

ll a two-character language code (usually in lower
case)

T a two-letter country or territory code (usually in
upper case)

codeset the name of the associated character code set; this

portion of the name is often optional.

By default, only a subset of supported locales appears in the drop list. To add
other supported values to the drop list, you must manually modify the
\Data\Std\stdConnProps.xml file in the product directory. For more information,
see the appendix on using Connector Configurator Express in this guide.

The default value is en_US. If the connector has not been globalized, the only valid
value for this property is en_US. To determine whether a specific connector has

been globalized, see the connector version list on these websites:

http:/ /www.ibm.com/software/websphere/wbiadapters/infocenter, or
http:/ /www.ibm.com /websphere/integration/wicserver/infocenter
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LogAtinterchangeEnd

Specifies whether to log errors to the integration broker’s log destination. Logging
to the broker’s log destination also turns on e-mail notification, which generates
e-mail messages for the MESSAGE_RECIPIENT specified in the InterchangeSystem.cfg
file when errors or fatal errors occur.

For example, when a connector loses its connection to its application, if
LogAtInterChangeEnd is set to true, an e-mail message is sent to the specified
message recipient. The default is false.

MaxEventCapacity

The maximum number of events in the controller buffer. This property is used by
flow control.

The value can be a positive integer between 1 and 2147483647. The default value is
2147483647.

MessageFileName

The name of the connector message file. The standard location for the message file
is \connectors\messages. Specify the message filename in an absolute path if the
message file is not located in the standard location.

If a connector message file does not exist, the connector uses
InterchangeSystem.txt as the message file. This file is located in the product
directory.

Note: To determine whether a specific connector has its own message file, see the
individual adapter user guide.

MonitorQueue

The logical queue that the connector uses to monitor duplicate events. It is used
only if the DeliveryTransport property value is J]MS and
DupTicateEventETimination is set to TRUE.

The default value is CONNECTORNAME /MONITORQUEUE

OADAutoRestartAgent

Specifies whether the connector uses the automatic and remote restart feature. This
feature uses the MQ-triggered Object Activation Daemon (OAD) to restart the
connector after an abnormal shutdown, or to start a remote connector from System
Monitor.

This property must be set to true to enable the automatic and remote restart
feature. For information on how to configure the MQ-triggered OAD feature, see
the Installation Guide for Windows.

The default value is false.

OADMaxNumRetry

Specifies the maximum number of times that the MQ-triggered OAD automatically
attempts to restart the connector after an abnormal shutdown. The
OADAutoRestartAgent property must be set to true for this property to take effect.
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The default value is 1000.

OADRetryTimelnterval

Specifies the number of minutes in the retry-time interval for the MQ-triggered
OAD. If the connector agent does not restart within this retry-time interval, the
connector controller asks the OAD to restart the connector agent again. The OAD
repeats this retry process as many times as specified by the OADMaxNumRetry
property. The OADAutoRestartAgent property must be set to true for this property
to take effect.

The default is 10.

PollIEndTime

Time to stop polling the event queue. The format is HH:MM, where HH represents
0-23 hours, and MM represents 0-59 seconds.

You must provide a valid value for this property. The default value is HH:MM, but
must be changed.

PollFrequency

The amount of time between polling actions. Set Po11Frequency to one of the
following values:

* The number of milliseconds between polling actions.

* The word key, which causes the connector to poll only when you type the letter
p in the connector’'s Command Prompt window. Enter the word in lowercase.

* The word no, which causes the connector not to poll. Enter the word in
lowercase.

The default is 10000.

Important: Some connectors have restrictions on the use of this property. To
determine whether a specific connector does, see the installing and
configuring chapter of its adapter guide.

PollQuantity

Designates the number of items from the application that the connector should poll
for. If the adapter has a connector-specific property for setting the poll quantity, the
value set in the connector-specific property will override the standard property
value.

PollStartTime

The time to start polling the event queue. The format is HH: MM, where HH represents
0-23 hours, and MM represents 0-59 seconds.

You must provide a valid value for this property. The default value is HH:MM, but
must be changed.

RequestQueue

The queue that is used by WebSphere InterChange Server Express to send business
objects to the connector.

The default value is CONNECTOR/REQUESTQUEUE.
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RepositoryDirectory

The location of the repository from which the connector reads the XML schema
documents that store the meta-data for business object definitions.

This value must be set to <REMOTE> because the connector obtains this
information from the InterChange Server Express repository.

ResponseQueue
Applicable only if DeTiveryTransport is JMS.

Designates the JMS response queue, which delivers a response message from the
connector framework to the integration broker. WebSphere InterChange Server
Express sends the request and waits for a response message in the JMS response
queue.

RestartRetryCount

Specifies the number of times the connector attempts to restart itself. When used
for a parallel connector, specifies the number of times the master connector
application-specific component attempts to restart the slave connector
application-specific component.

The default is 3.

RestartRetryinterval

Specifies the interval in minutes at which the connector attempts to restart itself.
When used for a parallel connector, specifies the interval at which the master
connector application-specific component attempts to restart the slave connector
application-specific component. Possible values ranges from 1 to 2147483647.

The default is 1.

SourceQueue

Applicable only if DeliveryTransport is JMS and ContainerManagedEvents is
specified.

Designates the JMS source queue for the connector framework in support of
guaranteed event delivery for JMS-enabled connectors that use a JMS event store.
For further information, see [’ContainerManagedEvents” on page 80)

The default value is CONNECTOR/SOURCEQUEUE.

SynchronousRequestQueue
Applicable only if DeliveryTransport is JMS.

Delivers request messages that require a synchronous response from the connector
framework to the broker. This queue is necessary only if the connector uses
synchronous execution. With synchronous execution, the connector framework
sends a message to the SynchronousRequestQueue and waits for a response back
from the broker on the SynchronousResponseQueue. The response message sent to
the connector bears a correlation ID that matches the ID of the original message.

The default is CONNECTORNAME/SYNCHRONOUSREQUESTQUEUE
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SynchronousResponseQueue
Applicable only if DeliveryTransport is JMS.

Delivers response messages sent in reply to a synchronous request from the broker
to the connector framework. This queue is necessary only if the connector uses
synchronous execution.

The default is CONNECTORNAME/SYNCHRONOUSRESPONSEQUEUE

SynchronousRequestTimeout
Applicable only if DeTiveryTransport is JMS.
Specifies the time in minutes that the connector waits for a response to a
synchronous request. If the response is not received within the specified time, then
the connector moves the original synchronous request message into the fault queue

along with an error message.

The default value is 0.

WireFormat

This is the message format on the transport. The setting isCwBO0.
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Appendix B. Connector Configurator Express

This appendix describes how to use Connector Configurator Express to set
configuration property values for your adapter.

The topics covered in this appendix are:

+ [“Overview of Connector Configurator Express” on page 89|

* |“Starting Connector Configurator Express” on page 90

« |“Creating a connector-specific property template” on page 90|

* |“Creating a new configuration file” on page 93

* |[“Setting the configuration file properties” on page 95|

+ [“Using Connector Configurator Express in a globalized environment” on page|

00

Overview of Connector Configurator Express

Connector Configurator Express allows you to configure the connector component
of your adapter for use with WebSphere InterChange Server Express.

You use Connector Configurator Express to:
* Create a connector-specific property template for configuring your connector.

* Create a connector configuration file; you must create one configuration file for
each connector you install.

* Set properties in a configuration file.
You may need to modify the default values that are set for properties in the
connector templates. You must also designate supported business object
definitions and maps for use with collaborations as well as specify messaging,
logging and tracing, and data handler parameters, as required.

Connector configuration properties include both standard configuration properties
(the properties that all connectors have) and connector-specific properties
(properties that are needed by the connector for a specific application or
technology).

Because standard properties are used by all connectors, you do not need to define
those properties from scratch; Connector Configurator Express incorporates them
into your configuration file as soon as you create the file. However, you do need to
set the value of each standard property in Connector Configurator Express.

The range of standard properties may not be the same for all brokers and all
configurations. Some properties are available only if other properties are given a
specific value. The Standard Properties window in Connector Configurator Express
will show the properties available for your particular configuration.

For connector-specific properties, however, you need first to define the properties
and then set their values. You do this by creating a connector-specific property
template for your particular adapter. There may already be a template set up in
your system, in which case, you simply use that. If not, follow the steps in
[“Creating a new template” on page 91| to set up a new one.
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Note: Connector Configurator Express runs only in a Windows environment. If
you are running the connector in a UNIX environment, use Connector
Configurator Express in Windows to modify the configuration file and then
copy the file to your UNIX environment.

Starting Connector Configurator Express

You can start and run Connector Configurator Express in either of two modes:
* Independently, in stand-alone mode
e From System Manager

Running Configurator Express in stand-alone mode

You can run Connector Configurator Express independently and work with
connector configuration files, irrespective of your broker.

To do so:

* From Start>Programs, click IBM WebSphere Business Integration Server
Express> Toolset Express>Development>Connector Configurator Express.

* Select File>New>Configuration File.

You may choose to run Connector Configurator Express independently to generate
the file, and then connect to System Manager to save it in a System Manager
project (see[“Completing a configuration file” on page 95|)

Running Configurator Express from System Manager

You can run Connector Configurator Express from System Manager.

To run Connector Configurator Express:
1. Open the System Manager.

2. In the System Manager window, expand the Integration Component Libraries
icon and highlight Connectors.

3. From the System Manager menu bar, click Tools>Connector Configurator
Express. The Connector Configurator Express window opens and displays a
New Connector dialog box.

To edit an existing configuration file:

1. In the System Manager window, select any of the configuration files listed in
the Connector folder and right-click on it.

2. Click the Standard Properties tab to see which properties are included in this
configuration file.

Creating a connector-specific property template

To create a configuration file for your connector, you need a connector-specific
property template as well as the system-supplied standard properties.

You can create a brand-new template for the connector-specific properties of your
connector, or you can use an existing file as the template.

+ To create a new template, see [‘Creating a new template” on page 91|

* To use an existing file, simply modify an existing template and save it under the
new name.
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Creating a new template

This section describes how you create properties in the template, define general
characteristics and values for those properties, and specify any dependencies
between the properties. Then you save the template and use it as the base for
creating a new connector configuration file.

To create a template:

1.
2.

Click File>New>Connector-Specific Property Template.

The Connector-Specific Property Template dialog box appears, with the
following fields:

Template, and Name

Enter a unique name that identifies the connector, or type of connector, for
which this template will be used. You will see this name again when you
open the dialog box for creating a new configuration file from a template.

Old Template, and Select the Existing Template to Modify

The names of all currently available templates are displayed in the Template
Name display.

To see the connector-specific property definitions in any template, select that
template’s name in the Template Name display. A list of the property
definitions contained in that template will appear in the Template Preview
display. You can use an existing template whose property definitions are
similar to those required by your connector as a starting point for your
template.

Select a template from the Template Name display, enter that template name in
the Find Name field (or highlight your selection in Template Name), and click
Next.

If you do not see any template that displays the connector-specific properties used
by your connector, you will need to create one.

Specifying general characteristics

When you click Next to select a template, the Properties - Connector-Specific
Property Template dialog box appears. The dialog box has tabs for General
characteristics of the defined properties and for Value restrictions. The General
display has the following fields:

* General:
Property Type
Updated Method
Description

* Flags
Standard flags

* Custom Flag
Flag

After you have made selections for the general characteristics of the property, click

the Value tab.

Specifying values

The Value tab enables you to set the maximum length, the maximum multiple
values, a default value, or a value range for the property. It also allows editable
values. To do so:

1.

Click the Value tab. The display panel for Value replaces the display panel for
General.
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Select the name of the property in the Edit properties display.

In the fields for Max Length and Max Multiple Values, make any changes. The
changes will not be accepted unless you also open the Property Value dialog
box for the property, described in the next step.

Right-click the box in the top left-hand corner of the value table and click Add.
A Property Value dialog box appears. Depending on the property type, the
dialog box allows you to enter either a value, or both a value and range. Enter
the appropriate value or range, and click OK.

The Value panel refreshes to display any changes you made in Max Length
and Max Multiple Values. It displays a table with three columns:

The Value column shows the value that you entered in the Property Value
dialog box, and any previous values that you created.

The Default Value column allows you to designate any of the values as the
default.

The Value Range shows the range that you entered in the Property Value
dialog box.

After a value has been created and appears in the grid, it can be edited from
within the table display. To make a change in an existing value in the table,
select an entire row by clicking on the row number. Then right-click in the
Value field and click Edit Value.

Setting dependencies
When you have made your changes to the General and Value tabs, click Next. The
Dependencies - Connector-Specific Property Template dialog box appears.

A dependent property is a property that is included in the template and used in
the configuration file only if the value of another property meets a specific
condition. For example, Po11Quantity appears in the template only if JMS is the
transport mechanism and DuplicateEventElimination is set to True.

To designate a property as dependent and to set the condition upon which it
depends, do this:

1.

In the Available Properties display, select the property that will be made
dependent.

In the Select Property field, use the drop-down menu to select the property
that will hold the conditional value.

In the Condition Operator field, select one of the following:
== (equal to)

!= (not equal to)

> (greater than)

< (less than)

>= (greater than or equal to)

<=(less than or equal to)

In the Conditional Value field, enter the value that is required in order for the
dependent property to be included in the template.

With the dependent property highlighted in the Available Properties display,
click an arrow to move it to the Dependent Property display.

Click Finish. Connector Configurator Express stores the information you have
entered as an XML document, under \data\app in the\bin directory where you
have installed Connector Configurator Express.
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Creating a new configuration file

You create a connector configuration file from a connector-specific template or by
modifying an existing configuration file.

Creating a configuration file from a connector-specific
template

Once a connector-specific template has been created, you can use it to create a
configuration file:

1. Click File>New>Connector Configuration.
2. The New Connector dialog box appears, with the following fields:
* Name

Enter the name of the connector. Names are case-sensitive. The name you
enter must be unique, and must be consistent with the file name for a
connector that is installed on the system.

Important: Connector Configurator Express does not check the spelling of
the name that you enter. You must ensure that the name is
correct.

* System Connectivity
The default broker is ICS. You cannot change this value.
* Select Connector-Specific Property Template

Type the name of the template that has been designed for your connector.
The available templates are shown in the Template Name display. When you
select a name in the Template Name display, the Property Template Preview
display shows the connector-specific properties that have been defined in
that template.

Select the template you want to use and click OK.

3. A configuration screen appears for the connector that you are configuring. The
title bar shows the integration broker and connector names. You can fill in all
the field values to complete the definition now, or you can save the file and
complete the fields later.

4. To save the file, click File>Save>To File or File>Save>To Project. To save to a
project, System Manager must be running.
If you save as a file, the Save File Connector dialog box appears. Choose *.cfg
as the file type, verify in the File Name field that the name is spelled correctly
and has the correct case, navigate to the directory where you want to locate the
file, and click Save. The status display in the message panel of Connector
Configurator Express indicates that the configuration file was successfully
created.

Important: The directory path and name that you establish here must match
the connector configuration file path and name that you supply in
the startup file for the connector.

5. To complete the connector definition, enter values in the fields for each of the
tabs of the Connector Configurator Express window, as described later in this
chapter.
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Using an existing file

To use an existing file to configure a connector, you must open the file in
Connector Configurator Express, revise the configuration, and then save the file as
a configuration file (*.cfg).

You may have an existing file available in one or more of the following formats:

* A connector definition file.
This is a text file that lists properties and applicable default values for a specific
connector. Some connectors include such a file in a \repository directory in
their delivery package (the file typically has the extension .txt; for example,
CN_XML.txt for the XML connector).

* An InterChange Server Express repository file.
Definitions used in a previous InterChange Server Express implementation of
the connector may be available to you in a repository file that was used in the
configuration of that connector. Such a file typically has the extension .in or
.out.

* A previous configuration file for the connector.
Such a file typically has the extension *.cfg.

Although any of these file sources may contain most or all of the connector-specific
properties for your connector, the connector configuration file will not be complete
until you have opened the file and set properties, as described later in this chapter.

To use an existing file to configure a connector, you must open the file in
Connector Configurator Express, revise the configuration, and then resave the file.

Follow these steps to open a *.txt, *x.cfg or *.in file from a directory:
1. In Connector Configurator Express, click File>Open>From File.

2. In the Open File Connector dialog box, select one of the following file types to
see the available files:

* Configuration (x.cfg)
* InterChange Server Express Repository (*.1in, *.out)

Choose this option if a repository file was used to configure the connector. A
repository file may include multiple connector definitions, all of which will
appear when you open the file.

o All files (*.*)

Choose this option if a *.txt file was delivered in the adapter package for
the connector, or if a definition file is available under another extension.

3. In the directory display, navigate to the appropriate connector definition file,
select it, and click Open.

Follow these steps to open a connector configuration from a System Manager

project:

1. Start System Manager. A configuration can be opened from or saved to System
Manager only if System Manager has been started.

2. Start Connector Configurator Express.

3. Click File>Open>From Project.
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Completing a configuration file

When you open a configuration file or a connector from a project, the Connector
Configurator Express window displays the configuration screen, with the current
attributes and values.

Connector Configurator Express requires values for properties described in the
following sections:

* [“Setting standard connector properties”|

+ [“Setting application-specific configuration properties” on page 96

» [“Specifying supported business object definitions” on page 97

* [“Associated maps” on page 98

« |“Setting trace/log file values” on page 99

Note: For connectors that use JMS messaging, an additional category may display,
for special configuration of data handlers that convert the data to business
objects. For further information, see [“Data handlers” on page 100

Setting the configuration file properties

When you create and name a new connector configuration file, or when you open
an existing connector configuration file, Connector Configurator Express displays a
configuration screen with tabs for the categories of required configuration values.

Standard properties differ from connector-specific properties as follows:

 Standard properties of a connector are shared by both the application-specific
component of a connector and its broker component. All connectors have the
same set of standard properties. These properties are described in Appendix A of
each adapter guide. You can change some but not all of these values.

* Application-specific properties apply only to the application-specific component
of a connector, that is, the component that interacts directly with the application.
Each connector has application-specific properties that are unique to its
application. Some of these properties provide default values and some do not;
you can modify some of the default values. The installation and configuration
chapters of each adapter guide describe the application-specific properties and
the recommended values.

The fields for Standard Properties and Connector-Specific Properties are
color-coded to show which are configurable:

A field with a grey background indicates a standard property. You can change
the value but cannot change the name or remove the property.

A field with a white background indicates an application-specific property. These
properties vary according to the specific needs of the application or connector.
You can change the value and delete these properties.

* You can configure Value fields.

e The Update Method displayed for each property indicates whether a component
or agent restart is necessary to activate changed values.

Setting standard connector properties
To change the value of a standard property:
1. Click in the field whose value you want to set.
2. Either enter a value, or select one from the drop-down menu if it appears.
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3. After entering all the values for the standard properties, you can do one of the
following;:

* To discard the changes, preserve the original values, and exit Connector
Configurator Express, click File>Exit (or close the window), and click No
when prompted to save changes.

* To enter values for other categories in Connector Configurator Express, select
the tab for the category. The values you enter for Standard Properties (or
any other category) are retained when you move to the next category. When
you close the window, you are prompted to either save or discard the values
that you entered in all the categories as a whole.

* To save the revised values, click File>Exit (or close the window) and click
Yes when prompted to save changes. Alternatively, click Save>To File from
either the File menu or the toolbar.

Setting application-specific configuration properties
For application-specific configuration properties, you can add or change property

names, configure values, delete a property, and encrypt a property. The default
property length is 255 characters.

1. Right-click in the top left portion of the grid. A pop-up menu bar will appear.
Click Add to add a property. To add a child property, right-click on the parent
row number and click Add child.

2. Enter a value for the property or child property.
3. To encrypt a property, select the Encrypt box.

4. Choose to save or discard changes, as described for [“Setting standard connector]
[properties” on page 95.|

The Update Method displayed for each property indicates whether a component or
agent restart is necessary to activate changed values.

Important: Changing a preset application-specific connector property name may
cause a connector to fail. Certain property names may be needed by
the connector to connect to an application or to run properly.

Encryption for connector properties

Application-specific properties can be encrypted by selecting the Encrypt check
box in the Edit Property window. To decrypt a value, click to clear the Encrypt
check box, enter the correct value in the Verification dialog box, and click OK. If
the entered value is correct, the value is decrypted and displays.

The adapter user guide for each connector contains a list and description of each
property and its default value.

If a property has multiple values, the Encrypt check box will appear for the first
value of the property. When you select Encrypt, all values of the property will be
encrypted. To decrypt multiple values of a property, click to clear the Encrypt
check box for the first value of the property, and then enter the new value in the
Verification dialog box. If the input value is a match, all multiple values will
decrypt.

Update method

Refer to the descriptions of update methods found in the Standard configuration
properties for connectors appendix, under [’Setting and updating property values” on|
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Connector properties are almost all static and the Update Method is Component
restart. For changes to take effect, you must restart the connector after saving the
revised connector configuration file.

Specifying supported business object definitions

Use the Supported Business Objects tab in Connector Configurator Express to
specify the business objects that the connector will use. You must specify both
generic business objects and application-specific business objects, and you must
specify associations for the maps between the business objects.

For you to specify a supported business object, the business objects and their maps
must exist in the system. Business object definitions, including those for data
handler meta-objects, and map definitions should be saved into Integration
Component Library (ICL) projects. For more information on ICL projects, see the
User Guide for WebSphere Business Integration Server Express.

Note: Some connectors require that certain business objects be specified as
supported in order to perform event notification or additional configuration
(using meta-objects) with their applications. For more information, see the
chapter on business objects in this guide as well as the Business Object
Development Guide.

To specify that a business object definition is supported by the connector, or to
change the support settings for an existing business object definition, click the
Supported Business Objects tab and use the following fields.

Business object name

To designate that a business object definition is supported by the connector, with
System Manager running:

1. Click an empty field in the Business Object Name list. A drop-down list
displays, showing all the business object definitions that exist in the System
Manager project.

2. Click on a business object to add it.

w

Set the Agent Support (described below) for the business object.

4. In the File menu of the Connector Configurator Express window, click Save to
Project. The revised connector definition, including designated support for the
added business object definition, is saved to the project in System Manager.

To delete a business object from the supported list:

1. To select a business object field, click the number to the left of the business
object.

2. From the Edit menu of the Connector Configurator Express window, click
Delete Row. The business object is removed from the list display.

3. From the File menu, click Save to Project.

Deleting a business object from the supported list changes the connector definition
and makes the deleted business object unavailable for use in this implementation
of this connector. It does not affect the connector code, nor does it remove the
business object definition itself from System Manager.

Agent support

If a business object has Agent Support, the system will attempt to use that business
object for delivering data to an application via the connector agent.
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Typically, application-specific business objects for a connector are supported by
that connector’s agent, but generic business objects are not.

To indicate that the business object is supported by the connector agent, check the
Agent Support box. The Connector Configurator Express window does not
validate your Agent Support selections.

Maximum transaction level

The maximum transaction level for a connector is the highest transaction level that
the connector supports.

For most connectors, Best Effort is the only possible choice.

You must restart the server for changes in transaction level to take effect.

Associated maps

Each connector supports a list of business object definitions and their associated
maps that are currently active in InterChange Server Express. This list appears
when you select the Associated Maps tab.

The list of business objects contains the application-specific business object which
the agent supports and the corresponding generic object that the controller sends
to the subscribing collaboration. The association of a map determines which map
will be used to transform the application-specific business object to the generic
business object or the generic business object to the application-specific business
object.

If you are using maps that are uniquely defined for specific source and destination
business objects, the maps will already be associated with their appropriate
business objects when you open the display, and you will not need (or be able) to
change them.

If more than one map is available for use by a supported business object, you will
need to explicitly bind the business object with the map that it should use.

The Associated Maps tab displays the following fields:

* Business Object Name
These are the business objects supported by this connector, as designated in the
Supported Business Objects tab. If you designate additional business objects
under the Supported Business Objects tab, they will be reflected in this list after
you save the changes by choosing Save to Project from the File menu of the
Connector Configurator Express window.

* Associated Maps

The display shows all the maps that have been installed to the system for use
with the supported business objects of the connector. The source business object
for each map is shown to the left of the map name, in the Business Object
Name display.

* Explicit
In some cases, you may need to explicitly bind an associated map.
Explicit binding is required only when more than one map exists for a particular
supported business object. When InterChange Server Express boots, it tries to
automatically bind a map to each supported business object for each connector.
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If more than one map takes as its input the same business object, the server
attempts to locate and bind one map that is the superset of the others.

If there is no map that is the superset of the others, the server will not be able to
bind the business object to a single map, and you will need to set the binding
explicitly.

To explicitly bind a map:

1.

In the Explicit column, place a check in the check box for the map you want
to bind.

2. Select the map that you intend to associate with the business object.
3. In the File menu of the Connector Configurator Express window, click Save
to Project.
4. Deploy the project to InterChange Server Express.
5. Reboot the server for the changes to take effect.
Resources

The Resource tab allows you to set a value that determines whether and to what
extent the connector agent will handle multiple processes concurrently, using
connector agent parallelism.

Not all connectors support this feature. If you are running a connector agent that
was designed in Java to be multi-threaded, you are advised not to use this feature,
since it is usually more efficient to use multiple threads than multiple processes.

Setting trace/log file values

When you open a connector configuration file or a connector definition file,
Connector Configurator Express uses the logging and tracing values of that file as
default values. You can change those values in Connector Configurator Express.

To change the logging and tracing values:
1. Click the Trace/Log Files tab.

2. For either logging or tracing, you can choose to write messages to one or both
of the following:

* To console (STDOUT):

Writes logging or tracing messages to the STDOUT display.

Note: You can only use the STDOUT option from the Trace/Log Files tab for
connectors running on the Windows platform.

To File:

Writes logging or tracing messages to a file that you specify. To specify the
file, click the directory button (ellipsis), navigate to the preferred location,
provide a file name, and click Save. Logging or tracing message are written
to the file and location that you specify.

Note: Both logging and tracing files are simple text files. You can use the file
extension that you prefer when you set their file names. For tracing
files, however, it is advisable to use the extension .trace rather than
.trc, to avoid confusion with other files that might reside on the
system. For logging files, .1og and .txt are typical file extensions.
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Data handlers

The data handlers section is available for configuration only if you have designated
a value of JMS for DeliveryTransport and a value of JMS for
ContainerManagedEvents. Adapters that make use of the guaranteed event
delivery enable this tab.

See the descriptions under ContainerManagedEvents in the Standard Properties
appendix for values to use for these properties.

Saving your configuration file

After you have created the configuration file and set its properties, you need to
deploy it to the correct location for your connector. Save the configuration in an
ICL project, and use System Manager to load the file into InterChange Server
Express.

The file is saved as an XML document. You can save the XML document in three

ways:

* From System Manager, as a file with a *.con extension in an Integration
Component Library, or

* In a directory that you specify.

¢ In stand-alone mode, as a file with a *.cfg extension in a directory folder.

For details about using projects in System Manager, and for further information
about deployment, see the User Guide for IBM WebSphere Business Integration Server
Express.

Completing the configuration

After you have created a configuration file for a connector and modified it, make
sure that the connector can locate the configuration file when the connector starts

up.

To do so, open the startup file used for the connector, and verify that the location
and file name used for the connector configuration file match exactly the name you
have given the file and the directory or path where you have placed it.

Using Connector Configurator Express in a globalized environment

Connector Configurator Express is globalized and can handle character conversion
between the configuration file and the integration broker. Connector Configurator
Express uses native encoding. When it writes to the configuration file, it uses
UTF-8 encoding.

Connector Configurator Express supports non-English characters in:

* All value fields

* Log file and trace file path (specified in the Trace/Log files tab)

The drop list for the CharacterEncoding and Locale standard configuration
properties displays only a subset of supported values. To add other values to the

drop list, you must manually modify the \Data\Std\stdConnProps.xml file in the
product directory.
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For example, to add the locale en_GB to the list of values for the Locale property,

open the stdConnProps.xml file and add the line in boldface type below:

<Property name="Locale"
isRequired="true"

updateMethod="component restart">
<ValidType>String</ValidType>

<ValidValues>

<DefaultValue>en US</DefaultValue>

</ValidValues>
</Property>

<Value>ja_JP</Value>
<Value>ko_KR</Value>
<Value>zh_CN</Value>
<Value>zh_TW</Value>
<Value>fr_FR</Value>
<Value>de DE</Value>
<Value>it_IT</Value>
<Value>es_ES</Value>
<Value>pt_BR</Value>
<Value>en_US</Value>
<Value>en_GB</Value>
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Notices

IBM may not offer the products, services, or features discussed in this document in
all countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or program(s) described in this publication
at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Burlingame Laboratory Director
IBM Burlingame Laboratory
577 Airport Blvd., Suite 800
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Burlingame, CA 94010
US.A

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not necessarily tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information may contain examples of data and reports used in daily business

operations. To illustrate them as completely as possible, the examples may include

the names of individuals, companies, brands, and products. All of these names are

fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

Programming interface information

Programming interface information, if provided, is intended to help you create
application software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.

However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks and service marks

The following terms are trademarks or registered trademarks of International
Business Machines Corporation in the United States or other countries, or both:
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IBM

the IBM logo
AIX
CrossWorlds
DB2

DB2 Universal Database
Domino
Lotus

Lotus Notes
MQIntegrator
MQSeries
Tivoli
WebSphere

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

MMX, Pentium, and ProShare are trademarks or registered trademarks of Intel
Corporation in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Other company, product or service names may be trademarks or service marks of

others. System Manager includes software developed by the Eclipse Project
(http:/ /www.eclipse.org/)

e
JAVA.

WebSphere Business Integration Server Express V4.3 and WebSphere Business
Integration Server Express Plus V4.3
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